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Preface 

This Preface introduces the guides and other information sources available to help 

you more effectively use Oracle Fusion Applications. 

Disclaimer 

The information contained in this document is intended to outline our general 

product direction and is for informational sharing purposes only, and should be 

considered in your capacity as a customer advisory board member or pursuant to 

your beta trial agreement only. It is not a commitment to deliver any material, code, 

or functionality, and should not be relied upon in making purchasing decisions. The 

development, release, and timing of any features or functionality described in this 

document remains at the sole discretion of Oracle. This document in any form, 

software or printed matter, contains proprietary information that is the exclusive 

property of Oracle. Your access to and use of this confidential material is subject to 

the terms and conditions of your Oracle software license and service agreement, 

which has been executed and with which you agree to comply. This document and 

information contained herein may not be disclosed, copied, reproduced or 

distributed to anyone outside Oracle without prior written consent of Oracle. This 

document is not part of your license agreement nor can it be incorporated into any 

contractual agreement with Oracle or its subsidiaries or affiliates. 

Other Information Sources 

My Oracle Support 

Oracle customers have access to electronic support through My Oracle Support. For 

information, visit http://www.oracle.com/support/contact.html or visit 

http://www.oracle.com/accessibility/support.html if you are hearing impaired. 

Use the My Oracle Support Knowledge Browser to find documents for a product 

area. You can search for release-specific information, such as patches, alerts, white 

papers, and troubleshooting tips. Other services include health checks, guided 

lifecycle advice, and direct contact with industry experts through the My Oracle 

Support Community. 
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Oracle Enterprise Repository 

Oracle Enterprise Repository provides visibility into service-oriented architecture 

assets to help you manage the lifecycle of your software from planning through 

implementation, testing, production, and changes. In Oracle Fusion Applications, 

you can use the Oracle Enterprise Repository for: 

• Technical information about integrating with other applications, including 

services, operations, composites, events, and integration tables. The 

classification scheme shows the scenarios in which you use the assets, and 

includes diagrams, schematics, and links to other technical documentation. 

• Publishing other technical information such as reusable components, policies, 

architecture diagrams, and topology diagrams. 

The Oracle Fusion Applications information is provided as a solution pack that you 

can upload to your own deployment of Oracle Enterprise Repository. You can 

document and govern integration interface assets provided by Oracle with other 

assets in your environment in a common repository. 

Documentation Accessibility 

For information about Oracle’s commitment to accessibility, visit the Oracle 

Accessibility Program website at http://www.oracle.com/us/corporate/accessibility 

/index.html. 

Comments and Suggestions 

Your comments are important to us. We encourage you to send us feedback about 

Oracle Fusion Applications Help and guides. Please send your suggestions to 

oracle_fusion_applications_help_ww@oracle.com. You can use the Send Feedback 

to Oracle link in the footer of Oracle Fusion Applications Help.  
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Introduction 

Oracle Enterprise Governance, Risk and Compliance (GRC) is a set of products that 

regulate activity in business-management applications. This document provides 

instructions for the installation (or upgrade) of the following GRC products: 

• Oracle Enterprise Governance, Risk and Compliance Manager (EGRCM) forms 

a documentary record of a company’s strategy for addressing risk and complying 

with regulatory requirements. 

• Oracle Advanced Controls enables users to create “models” and “continuous con-

trols.” Two Advanced Controls applications run from within the GRC platform: 

– In Oracle Enterprise Transaction Controls Governor (ETCG), models and 

controls specify circumstances under which individual transactions display 

evidence of error, fraud, or other risk.  

– In Oracle Application Access Controls Governor (AACG), models and 

controls define conflicts among duties that can be assigned in a company’s 

applications, and identify users who have access to those conflicting duties. 

AACG can also implement “preventive analysis” — it can evaluate controls 

as duties are assigned to users of the company’s applications, preventing them 

from gaining risky access. 

• Oracle Fusion Application Access Controls Governor (FAACG) is a specialized 

installation of AACG that applies access models and controls in Oracle Fusion 

Applications. 

• Oracle Fusion GRC Intelligence (GRCI) extracts data from GRC for display in 

dashboards and reports. 

You can install GRC on its own, or to be integrated with an OID LDAP server that 

manages GRC users. (OID stands for Oracle Internet Directory; LDAP for Light-

weight Directory Access Protocol.)  

You can embed a GRCI instance within GRC. If you intend to use GRCI, complete 

the installation of GRC first (see Chapter 2). Then integrate GRCI with GRC (see 

Chapter 3). 

You can install GRC on a server that you own and maintain (a “conventional” 

installation), or you can use Oracle VM Server to deploy an image of GRC initially 

configured by Oracle. 
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Prerequisites  

If you intend to deploy a VM image of GRC, you need to install Oracle VM Manager 

and Oracle VM Server 3.1.1, and the remaining prerequisites do not apply to you. 

If you intend to perform a conventional GRC installation, then GRC runs on a 64-bit 

Linux server. Be sure the following lines exist in the /etc/security/limits.conf file: 

*    soft    nproc     8192 

*    hard    nproc     32768 

*    soft    nofile    65536 

*    hard    nofile    131072 

If you are installing on Solaris, set the following configuration parameter in 

/etc/system to protect against exploitation of buffer overflow attacks. (There is no 

need to do this for OEL or other Linux variations.) 

noexec_user_stack = 1 

The installation of Enterprise Governance, Risk and Compliance requires that the fol-

lowing also be installed on the server: 

• Oracle database 11g Release 2. See “Creating GRC and DA Schemas” (page 1-3). 

The GRC database can be one in which Real Application Clusters (RAC) is en-

abled. To deploy GRC on a RAC instance, install an Oracle 11gR2 RAC database 

with Single Client Access Name (SCAN) mode on two or more nodes. Also 

complete procedures described in “Installing a Driver for RAC” (page 2-17) and  

“GRC Configuration” (page 2-18).  

• Java: Sun Java Development Kit 1.7 or higher. JRockit JDK R28.1.3 for Java 

SE 6 with JRockit Mission Control 4.0.1 for Linux x86-64 is also supported. 

GRC must have its own dedicated Java container. It was not designed to coexist 

in a container with other web applications. 

• Middleware: GRC may run with WebLogic Server or Tomcat Application Server.  

– To use WebLogic, also use related components — some combination of 

Service Oriented Architecture (SOA), Repository Creation Utility (RCU), 

and Application Development Runtime (ADR). 

Install GRC with SOA if you intend to integrate with other applications and 

want them to consume SOA worklists. In this case, you need WLS 10.3.6, 

SOA 11.1.1.6, and  RCU 11.1.1.6. 

Otherwise, install GRC without SOA. In this case, you need WLS 10.3.6 

and ADR 11.1.1.6. (You can use GRC with a SOA instance you’ve already 

installed for other purposes. In that case, install the same middleware com-

ponents you would if you were installing GRC without SOA.)  

If you intend to run GRCI with GRC, use middleware components installed 

for GRC. In this case, however, you need RCU 11.1.1.6 even if you’ve 

installed GRC without SOA (or to run with a pre-existing SOA instance).  

– Alternatively, use version 6.0.24 of Tomcat Application Server. 

Note: If you intend to run Fusion Application Access Controls Governor, you 

must install GRC with WebLogic and SOA. If you will not run FAACG, you 

can install GRC with WebLogic or with Tomcat Application Server. If you use 
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WebLogic, you can install GRC to run with or without SOA. However, in this 

case SOA is an option, not a requirement, and is not recommended. 

If you intend to embed GRCI into your GRC instance, you must choose 
WebLogic. If you use Tomcat, you can install GRCI as a standalone application. 

• An OID LDAP server, if you intend to install GRC so that its users are managed 

by such a server. 

On the server or a client system, either of the following web browsers can display 

the GRC interface: 

• FireFox 17 

• Microsoft Internet Explorer 8.x and 9.x, with the Adobe SVG plugin available 

from http://www.adobe.com/svg/viewer/install/mainframed.html. 

For details about supported components, see the Oracle Enterprise Governance, 

Risk and Compliance Certifications Document. 

Upgrading 
You can upgrade to GRC version 8.6.4.5000 from GRC 8.6.4.4240. To do so, 

essentially, perform an installation in which you reuse database, schema, and 

(potentially) middleware components installed for the earlier version.  

Concerning middleware, you may reuse Tomcat Application Server components. 

You may not reuse WebLogic components, however; instead, install WebLogic 
10.3.6 tech stack components, as instructed in this manual.  

As you upgrade, you must also do the following: 

• Reuse the “repository” directory that stores ETL data generated by Transaction 

Controls Governor, and retain the contents of that directory. Ensure that a report 
repository also exists. (See “Creating GRC Repositories” on page 2-3.) 

• After upgrading Advanced Controls to version 8.6.4.5000 and connecting it to 

datasources, synchronize data for each datasource. (See “Configuring Data-

sources and Synchronizing Data” on page 5-3.) 

• After upgrading ETCG, evaluate all transaction models inherited from the earlier 

version. See the Enterprise Transaction Controls Governor User Guide for 

information on running transaction models. See the Release Notes for version 

8.6.4.5000 for information on how an upgrade affects existing transaction 
models and controls. 

Before upgrading, back up your database, schema, middleware components, and 

report and transaction ETL repositories.  

Creating GRC and DA Schemas 
In the Oracle database, create a GRC schema for use by GRC. If you intend also to 

install GRCI, create a second schema, known as the Data Analytics (DA) schema. 

The following is a sample script that serves for the creation of either schema. You 

are assumed to have created tablespaces; each schema requires its own. The values 

you choose for tablespace name, user (schema) name, and password would be dis-
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tinct for each schema, and are represented here by TablespaceName, UserName, and 

UserPassword, respectively. Each password must contain at least six characters. 

create user UserName identified by UserPassword default 

tablespace TablespaceName quota unlimited on TablespaceName 

quota 0k on system; 

grant connect, resource to UserName; 

grant create any view to UserName; 

grant create any table to UserName; 

grant drop any table to UserName; 

grant create synonym to UserName; 

Run the following commands as the system user: 

ALTER SYSTEM SET open_cursors=5000 scope=spfile; 

ALTER SYSTEM SET processes=3000 scope=spfile; 

ALTER SYSTEM SET deferred_segment_creation=FALSE scope=spfile; 

After running these commands, bounce the database.  

GRC may display information in any of twelve languages. To use the multilingual 

capability, set up the database that hosts the GRC schema for UTF-8 encoding. To 

do so, execute this command, for which the return value should be AL32UTF8: 

SELECT value$ FROM sys.props$ WHERE name = 'NLS_CHARACTERSET' ; 

Once installation is complete, users will be able to use a set of Schema Import/Export 

fields (available in the Properties tab of a Manage Application Configurations page) 

to download the GRC schema, or to upload a copy of it. To set up this feature, create 

a DATA_PUMP_DIR directory, which provides temporary storage for schema-file copies.  

In the following commands, use a SQL editor such as SQL*Plus; replace <Grc_User> 

with the name of the admin user for the GRC application server; replace <dir> with 

the path to a directory that will serve as your DATA_PUMP_DIR directory.  

1. Create a directory object, and grant READ and WRITE access to it.  

CREATE DIRECTORY DATA_PUMP_DIR AS <dir>; 

GRANT READ, WRITE ON DIRECTORY DATA_PUMP_DIR TO <Grc_User>; 

2. Ensure that <Grc_User> has EXP_FULL_DATABASE and IMP_FULL_DATABASE 

roles. For a list of roles within your security domain, enter the following: 

SELECT * FROM SESSION_ROLES; 

3. If the <Grc_User> does not have these roles, execute the following commands: 

GRANT EXP_FULL_DATABASE, IMP_FULL_DATABASE TO <Grc_User>; 

GRANT CREATE SESSION TO <Grc_User>; 

GRANT CREATE TABLE TO <Grc_User>; 

GRANT UNLIMITED TABLESPACE TO <Grc_User>; 

4. Grant an additional permission, required for the import operation: 

GRANT EXECUTE ON UTL_FILE TO <Grc_User>; 

Before a schema file can be imported, an empty schema must be created for it, and a 

tablespace must be created for the schema. The script shown above may be used to 

create the schema. The following is an example of a script that creates a tablespace if 

the original GRC schema and its copy will reside in the same database. UserName is 

the name of the copied schema, and UserNameTS is the name of the tablespace. 

CREATE USER "UserName" IDENTIFIED BY "UserName" DEFAULT 

TABLESPACE UserNameTS QUOTA UNLIMITED ON UserNameTS; 
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Installing GRC 

To perform a conventional GRC installation, use procedures in this chapter. If you 

intend to deploy a VM image of GRC, ignore this chapter and skip to Chapter 4.  

For a conventional installation, decide whether you will use WebLogic or Tomcat. 

(WebLogic is required if you intend to run FAACG or to embed GRCI in your GRC 

instance.) If WebLogic, decide whether you are installing with SOA. (Do so if you 

are integrating with other applications that will consume SOA worklists, and have no 

existing SOA installation; or if you intend to run FAACG. Otherwise, do not). 

Then complete the appropriate one of the following procedures. (Summary proce-

dures appear here, with details given in later sections of this chapter.)  

If you are installing GRC on WebLogic with SOA: 

1. Download files to the GRC server and prepare them for use. Ensure that two 

directories, for the storage of report and ETL data generated by GRC, are ready 

for use. 

2. Install WebLogic Server and other components — Repository Creation Utility 

(RCU) and Service Oriented Architecture (SOA).  

3. Create a WebLogic domain. This entails setting up an Administration Server 

and a “managed server” for SOA. Within the domain, install “SOA composites” 

and “keystores,” set up security credentials, enable “embedded LDAP,” and create 

a soaadmin user. 

4. If you intend to install GRC so that an OID LDAP repository manages its users, 

configure that repository. 

5. Perform configuration steps in a WebLogic Server Administration Console, and 

modify memory and other settings to conform to GRC requirements. 

6. Perform configuration steps in a GRC Manage Application Configurations page. 

7. Run WebLogic to complete the installation. 

If you are installing GRC on WebLogic to be used without SOA, or to be used with 

an already existing SOA instance: 

1. Download files to the GRC server and prepare them for use. Ensure that two 

directories, for the storage of report and ETL data generated by GRC, are ready 

for use. 

2. Install WebLogic Server and Application Development Runtime.  
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3. Create a WebLogic domain. This entails setting up an Administration Server 

(but no managed server).  

4. If you intend to install GRC so that an OID LDAP repository manages its users, 

configure that repository. 

5. For GRC with a pre-existing SOA Server, configure “SOA composites” and 

“keystores,” set up security credentials, enable “embedded LDAP,” and create a 

soaadmin user for that server. (For GRC without SOA, skip this step.) 

6. Perform configuration steps in a WebLogic Server Administration Console, and 

modify memory and other settings to conform to GRC requirements. 

7. Perform configuration steps in a GRC Manage Application Configurations page. 

8. Run WebLogic to complete the installation. 

If you are installing GRC with Tomcat: 

1. Download files to the GRC server and prepare them for use. Ensure that two 

directories, for the storage of report and ETL data generated by GRC, are ready 

for use. 

2. Install Tomcat (as instructed in its documentation). On the GRC server, modify 

Tomcat memory settings, and run a Tomcat setup script provided with GRC. 

3. Perform configuration steps in a GRC Manage Application Configurations page. 

4. Run Tomcat to complete the installation. 

Downloading Files  

Create a staging directory on your GRC server. (Throughout this document, 

<grc_stage> represents the full path to this directory.) 

To install GRC, download a file called grc864_5259.zip to <grc_stage>, and extract 

its contents there. To validate your download, generate a checksum and compare it 

with a checksum value published in Release Notes for the instance you are instal-

ling. To generate a checksum, run the command md5sum grc.ear.  

If you expect to use embedded GRCI with WebLogic, download files called 

grc864_5259_OBIEE_1of3.tar.gz, grc864_5259_OBIEE_2of3.tar.gz, and grc864_5259_ 

OBIEE_3of3.tar.gz to <grc_stage>. See Chapter 3 for instructions on the use of these 

files.  

If you intend to use WebLogic, you need middleware components appropriate for 

the installation you will perform. These are available on E-Delivery. Middleware 

components include some combination of the following (see “Prerequisites” on 

page 1-2):  

• Oracle Weblogic Server 11gR1 (10.3.6) Generic and Coherence 

• Oracle SOA Suite 11gR1 (11.1.1.6.0) 

• Oracle Repository Creation Utility 11g (11.1.1.6.0) for Linux x86 

• Oracle Application Development Runtime 11g Patch Set 5 (11.1.1.6.0).  

If you intend to use Tomcat, download it from its site on the Internet.  
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Creating GRC Repositories 

Create two “repositories” — directories that store data generated by GRC. A report 

repository stores copies of GRC reports that users schedule to be run. A second repos-

itory stores ETL data used for transaction analysis. Each can reside on an NFS mount 

or any valid directory to which the user running WebLogic or Tomcat has full per-

missions.  

Note the paths to the repositories, as you will need to supply them later as configu-

ration values.  

Setting Up WebLogic 

If you will use WebLogic, install WebLogic Server (WLS) and related components 

generally as their documentation instructs you to do. You will need to make choices 

that support their use with GRC. Complete procedures, documented from here to 

page 2-16, that are appropriate to the installation you are performing (GRC with or 

without SOA). Then skip “Setting Up Tomcat Application Server.” If your GRC data-

base supports RAC, continue at “Installing a Driver for RAC,” or if it does not, con-

tinue at “GRC Configuration.” Both appear on page 2-18.  

If, instead, you intend to use Tomcat, skip ahead to “Setting Up Tomcat Application 

Server” on page 2-16. 

Initial WebLogic Installation 

Ensure that Sun JDK 1.7 is in the path to install and run WebLogic Server. Then 

install WLS as a Standard Default Deployment. 

Next, if you are installing GRC with SOA, complete these procedures: 

1. Install Repository Creation Utility (RCU). These RCU components are required:  

• Metadata Services (MDS schema) 

• SOA Infrastructure (SOAINFRA schema) 

• Business Activity Monitoring (ORABAM schema) 

• User Messaging Service (ORASDPM schema) 

2. Once RCU is installed, run it to install SOA schemas: 

a. Set an XEDB environment variable to provide connection information for 

your GRC database. Enter the following: 

export XEDB=Dbhost:Dbport:SID 

Replace Dbhost with the fully qualified domain name (FQDN) of your GRC 

database server, Dbport with the port number at which the database communi-

cates with other applications, and SID with the service identifier value 

configured for the database in the tnsnames.ora file.  
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b. Use the createRepository option in RCU to create repositories. Navigate to 

<RCU_HOME>/bin (in which <RCU_HOME> represents the highest-level 

directory in which RCU components exist). Then execute this command:  

./rcu -silent -createRepository -connectString $XEDB 

-dbUser sys -dbRole sysdba -lockSchemas false 

-schemaPrefix EGRCM -component SOAINFRA -component MDS 

-component ORASDPM -component BAM 

As you run the script, you will be prompted to create passwords for each of 

SOAINFRA, MDS, ORASDPM, and BAM.  

3. Install Oracle SOA Suite. Enter the value “soa” as the Oracle Home Directory 

on the Specify Installation Location screen. 

If you are installing GRC without SOA, or GRC to be used with a pre-existing 

SOA instance, install ADR. Do not install either RCU or SOA.  

Creating a WebLogic Domain 

For any installation, create a new WebLogic domain. To do so, execute the follow-

ing command:  

<MW_HOME>/wlserver_10.3/common/bin/config.sh 

Note: <MW_HOME> represents the full path to the home directory of your middle-

ware installation — the highest-level directory in which Fusion Middleware com-

ponents exist, including WebLogic. 

The config.sh script runs a Fusion Middleware Configuration Wizard, which prompts 

you to complete several steps: 

1. Select templates.  

For any installation, one template is selected automatically: “Base WebLogic 

Server Domain — 10.3.6.0.” Also select “Oracle Enterprise Manager — 

11.1.1.0.” When you do, a third template, “Oracle JRF — 11.1.1.0,” is selected 

with it. 

Only if you are installing GRC with SOA, select three more templates: “Oracle 

SOA Suite — 11.1.1.0,” “Oracle WSM Policy Manager — 11.1.1.0,” and 

“Oracle JRF Webservices Asynchronous Services — 11.1.1.0.” 

2. Create a name for your WebLogic domain. Use any name you wish. (Throughout 

this document, the value <grc_domain> represents the name you configure here.) 

In two other fields — Domain Location and Application Location — accept 

default values. 

3. At a Configure Administrator Username Password prompt, create a WebLogic 

Server username and password.  

4. At a Configure Server Start Mode and JDK prompt, select “Production Mode.” 

In the JDK Selection area, ensure that the correct JDK is selected. (This is the 

JDK instance you confirmed to be in the path to install and run WebLogic under 

“Initial WebLogic Installation” on page 2-3.) If necessary, use the “Other JDK” 

option to browse. 
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5. For GRC with SOA only, respond to a Configure JDBC Component Schema 

prompt. Enter details you’ve already established as you used RCU to create 

repositories (see step 2b of “Initial WebLogic Installation” on page 2-4). When 

you complete this step, you should see the value “Test Successful” at a Test 

Component Schema prompt. 

6. For any installation, select “Administration Server” at a Select Optional Con-

figuration prompt. Also select “Managed Servers, Clusters and Machines” if 

you are installing GRC with SOA, but not if you are installing GRC to run with a 

pre-existing SOA or without SOA. 

7. At a Configure the Administration Server prompt, enter the IP address of the 

machine running the WebLogic Server. Also select an unused port for it. 

8. If you are installing GRC to run FAACG, or GRC with SOA , a Configure Man-

aged Servers prompt appears: 

• For GRC with FAACG, click the Add button. In the row that appears, enter 

a name for the GRC server and the IP address of the machine running the 

WebLogic Server. Then continue at step 9. 

• For GRC with SOA, confirm that the Configure Managed Servers prompt 

displays a row for a SOA Server. This row appears as a result of GRC-

specific configuration you’ve already completed. Note the IP address and 

port, which you’ll need to enter later in a GRC Worklist page. Continue at 

step 9. 

If you are installing GRC without SOA, or to run with a pre-existing SOA, you 

need not create a managed server. The Configure Managed Servers page and 

several other Configuration Wizard pages do not appear. Skip ahead to step 12. 

9. Skip the Configure Clusters page. 

10. In a Configure Machines page, select the Unix Machine tab. Click Add. Assign 

any name, and accept defaults for all other fields. 

11. In the Assign Servers to Machines page, select the servers listed in the left box. 

Move them to machine you created in step 10, which is listed in the right box. 

12. In the Summary page, select Create. 

Preparing Additional Files 

Complete these additional steps when the config.sh script finishes running: 

1. Copy the following files from 

<MW_HOME>/oracle_common/modules/oracle.adf.model_11.1.1, to 

<MW_HOME>/user_projects/domains/<grc_domain>/lib: 

• adfm.jar 

• adfdt_common.jar 

• adfmweb.jar 

2. Copy the following files from <grc_stage>/lib to 

<MW_HOME>/user_projects/domains/<grc_domain>/lib: 

• groovy-all-1.6.3.jar 

• xdoparser-10.1.3.4.jar 
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3. If you are installing GRC to run FAACG, invoke the WebLogic scripting tool 

— wlst.sh — from <MW_HOME>/oracle_common/common/bin. Use it to apply 

the JRF template to the GRC managed server you created in step 8 of “Creating a 

WebLogic Domain” (<grc_server> in the following example): 

applyJRF('<grc_server>','<MW_HOME>/user_projects/domains/<g

rc_domain>') 

If you do not intend to run FAACG, skip this step. 

4. Create a directory called grc864 (for example, <MW_HOME>/grc864). This 

directory should be entirely distinct from the <grc_stage> directory you created 

as you downloaded GRC files. 

5. Navigate to <grc_stage>/dist, and locate the file grc.ear. Copy it to the grc864 

directory, and extract its contents there.  

In addition, as you complete GRC installation procedures, you will use scripts named 

startWeblogic.sh and stopWeblogic.sh to start and stop the WebLogic Administration 

Server. First, edit the stopWeblogic.sh file as follows: 

1. Open <MW_HOME>/wlserver_10.3/common/bin/stopWeblogic.sh in a text 

editor. 

2. Locate a line in the file similar to the following: 

echo "shutdown('${SERVER_NAME}','Server', 

ignoreSessions='true')" 

>>"shutdown.py" 

3. Edit this line to include a force=‘true’ parameter: 

echo "shutdown('${SERVER_NAME}','Server', force='true' 

ignoreSessions='true')" 

>>"shutdown.py" 

4. Save and close the file.  

Whenever you run the stopWeblogic.sh script, wait 30 seconds for all processes to 

terminate.  

Configuring External OID LDAP 

This section applies to you only if you intend to install GRC so that an external OID 

LDAP repository manages its users. If you do not, ignore this section and skip ahead 

to “Installing SOA Composites” on page 2-9. If you do, complete these steps: 

1. Log in to the WebLogic Server Administration Console: 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-5.) 

2. Click on the “Security Realms” link in your application’s Security Settings. 

3. Click on the “myrealm” link in the table. 

4. Click on the “Providers” tab. 
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5. Click on the New button and enter the following values: 

• Name: OIDAuthenticator 

• Type: OracleInternetDirectoryAuthenticator 

6. Click on the “OIDAuthenticator” link and then click on the “Provider Specific” tab. 

7. Supply values for properties in the “Provider Specific” screen. (Italicized entries 

are literal values, to be entered as they are shown.) 

• Host: The FQDN of the LDAP provider (your OID instance). 

• Port: The port number at which the host communicates with other applica-

tions. 

• Principal: The username for the OID administrative user, preceded by cn=. 

• Credential: The password configured for the OID administrative user. 

• Confirm Credential: The password configured for the OID administrative user. 

• SSLEnabled: Leave this box unchecked. 

• User Base DN: The LDAP path to the store for user information. For example: 

cn=FusionUsers,cn=users,dc=us,dc=oracle,dc=com 

• All Users Filter: (&(cn=*)(objectclass=person)) or 

(&(uid=*)(objectclass=person)), depending on your configuration. If you 

intend to run FAACG, you must select the “uid” value. 

• User From Name Filter: (&(cn=%u)(objectclass=person)) or 

(&(uid=%u)(objectclass=person)), depending on your configuration. If you 

intend to run FAACG, you must select the “uid” value. 

• User Search Scope: subtree 

• User Name Attribute: cn or uid, depending on your configuration. If you 

intend to run FAACG, you must select the “uid” value. 

• User Object Class: person 

• Use Retrieved User Name as Principal: Select this checkbox. 

• Group Base DN: The LDAP path to the store for group (enterprise role) 

information. For example: cn=FusionGroups,cn=groups,dc=us,dc=oracle, 

dc=com 

• All Groups Filter: (&(cn=*)(|(objectclass=groupofUniqueNames) 

(objectclass=orcldynamicgroup))) 

• Group From Name Filter: (|(&(cn=%g)(objectclass=groupofUniqueNames)) 

(&(cn=%g)(objectclass=orcldynamicgroup))) 

• Group Search Scope: subtree 

• Group Membership Searching: unlimited 

• Static Group Name Attribute: cn 

• Static Group Object Class: groupofuniquenames 

• Static Member DN Attribute: uniquemember 

• Static Group DN from Member DN filter: (&(uniquemember=%M)(objectclass= 

groupofuniquenames)) 
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• Dynamic Group Name Attribute: cn 

• Dynamic Group Object Class: orcldynamicgroup 

• Dynamic Member URL Attribute: labeleduri 

• User Dynamic Group DN Attribute: Leave this field blank. 

• Connection Pool Size: 6 

• Connect Timeout: 0 

• Connection Retry Limit: 1 

• Parallel Connect Delay: 0 

• Results Time Limit: 0 

• Keep Alive Enabled: Leave this box unchecked. 

• Follow Referrals: Select this checkbox. 

• Bind Anonymously On Referrals: Leave this box unchecked. 

• Propagate Cause For Login Exception: Leave this box unchecked. 

• Cache Enabled: Select this checkbox. 

• Cache Size: 32 

• Cache TTL: 60 

• GUID Attribute: orclguid 

8. Save your settings, then click on “Activate Changes” on the left, topmost panel. 

9. Click the “OIDAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

10. Click the “DefaultAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

11. Click the Reorder button. Select “OIDAuthenticator” from the available provid-

ers, and move it to the top. To do so, click on the arrow on the right side, then 

click OK. 

12. Click on “Activate Changes” from the Change Center, then log out. 

13. Stop the WebLogic Administration Server and, if one is installed, the SOA 

Server. (If you are installing GRC with SOA, the latter is the managed server 

discussed in step 8 of “Creating a WebLogic Domain,” page 2-5. If you are 

installing GRC to run with a pre-existing SOA instance, this is the SOA server 

created for that instance.) 

14. Edit boot.properties files. There are two possibilities: 

• GRC, OID LDAP, and (if applicable to you) SOA components exist on one 

instance of WebLogic Server (WLS). If so, up to two boot.properties files 

may exist, one for the Administration Server and (if you use SOA) one for 

the SOA Server. 

In this case, edit each file to set a username value equal to your OID admin-

istrative user name — the “Principal” in step 7 of this procedure, without 

the cn= prefix. Set a password value equal to that user’s password — the 

“Credentials” value in step 7 of this procedure. 
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• GRC and OID LDAP exist on distinct instances of WLS. If so, SOA may be 

installed on either WLS instance (or is not installed at all, if you choose not 

to use it). In this case, two or three boot.properties files exist, for the GRC 

Administration Server on the GRC instance of WLS, for the OID Administra-

tion Server on the OID LDAP instance of WLS, and (if you use SOA) the 

SOA Server on either WLS instance. 

In this case, edit boot.properties files on the OID LDAP instance of WLS to 

set the username and password values equal to those for the OID adminis-

trative user (as defined earlier in this step). Edit boot.properties files on the 

GRC instance of WLS to set the username and password values to those 

you created in step 3 of “Creating a WebLogic Domain” (page 2-4). 

The boot.properties files exist in these locations:  

• For the Administration Server, navigate to 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/AdminServer/s

ecurity/boot.properties 

• For the SOA Server (if you have installed one), navigate to 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/<SoaServerNa

me>/security/ boot.properties 

15. Start the Administration Server and SOA Server.  Check whether LDAP is con-

figured successfully: Log in to the WebLogic console (see step 1of this proce-

dure), go to Security Realms → myRealm, and click on Users and Groups. You 

should see your LDAP users and groups.  

Installing SOA Composites 

If you are installing GRC with SOA, or to run with a pre-existing SOA, create “SOA 

composites.” (If you are installing GRC without SOA, this does not apply; skip 

ahead to “WebLogic Console Configuration” on page 2-14.) In broad terms, deploy 

two composite files, sca_grccomposite.jar and sca_grcclientcomposite.jar. In the 

process of deploying  the second of these, you will also deploy a GRC client ear file. 

First, complete preliminary steps:  

1. Ensure that the Administration Server and SOA Server are running. (If you are 

installing GRC with SOA, the latter is the managed server discussed in step 8 of 

“Creating a WebLogic Domain,” page 2-5. If you are installing GRC to run with 

a pre-existing SOA instance, this is the SOA server created for that instance.) 

2. Create a temporary folder. (Throughout this section, <temp> represents the full 

path to this folder.) 

3. Locate the file grc-soa-composite-8.6.4.5-SNAPSHOT-package.zip in 

<grc_stage>/dist/soa. Extract its contents in <temp>. 

Next, deploy sca_grccomposite.jar:  

1. Access Enterprise Manager (EM) at:  

http://host:port/em 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-5.) 
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2. From the left navigator and under your domain, expand SOA and right-click on 

soa-infra. 

3. Select SOA Deployment → Deploy. 

4. Under the Archive or Exploded Directory section, select the radio button for 

Archive on the server where Enterprise Manager is running and enter <temp>/ 

sca_grccomposite.jar. Under Configuration Plan, select No external configuration 

plan.  Then click Next. 

5. On the Select Target page, select the partition in which to deploy this SOA com-

posite application. Partitions enable you to group SOA composite applications 

logically into separate sections. Even if only one partition is available, you must 

explicitly select it. A partition named default is automatically included with 

Oracle SOA Suite. 

If you want to deploy to a partition that does not exist or if the server contains 

no partition, exit the wizard and create the partition before deploying the com-

posite. You can create partitions in the Manage Partition page, accessible from 

the SOA Infrastructure menu. 

6. Review your selections on the Confirmation page, and select to deploy the SOA 

composite as the default revision. The default revision is instantiated when a new 

request comes in.  

7. Click Deploy. Processing messages are displayed. 

When deployment has completed, the home page of the newly deployed composite 

revision appears automatically. A confirmation message at the top of the page tells 

you that the composite has been deployed successfully. 

Next, deploy the GRC client ear: 

1. Create a new directory called grc-client-864. Locate the file grc-client-8.6.4.5-

SNAPSHOT.ear in <grc_stage>/dist/soa, and extract its contents in the grc-client-

864 directory.  

2. Open the WebLogic Server Administration Console: 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of 

“Creating a WebLogic Domain” on page 2-5.) 

3. In the Change Center panel, click Lock & Edit. 

4. In the Domain Structure panel, click on Deployments. 

5. In the Summary of Deployments panel, select the Control tab. 

6. In the Summary of Deployments panel, click on the Install button. 

7. In the path field of the Install Application Assistant panel, enter the full path to 

the grc-client-864 directory you created in step 1. Select grc-client-864 (open 

directory) under Current Location. 

8. In the Install Application Assistant panel, press Next. 

9. In the Install Application Assistant panel, choose Install this deployment as an 

application in the Choose Targeting Style section. Click Next. Then select the 

Administration Server if your SOA Server exists on the same domain as your 

Administration Server. (You are not presented with an opportunity to select a 

server here if your Administration Server is the only server on your domain.) 
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10. In the Install Application Assistant panel, choose I will make this deployment 

accessible from the following location in the Source Accessibility section. 

Accept all other defaults. 

11. In the Install Application Assistant panel, select Finish.  

12. In the Install Application Assistant panel, select Save, then Activate Changes. 

On the Deployment screen, the status of the grc-client-864 is Prepared. 

13. Select the grc-client-864 application. Click Start, select Servicing all requests, 

and wait until the application status changes to Active. 

Finally, deploy sca_grcclientcomposite.jar: 

1. Go to <temp> and open the file grcclient-composite_cfgpla.xml for editing. 

2. Replace all instances of SoaServerHostName with the FQDN of the WebLogic 

Administration Server in which you deployed the grc-client ear in the previous 

procedure.  

3. Replace all instance of PortNo with the port number of the Administration 

Server in which you deployed the grc-client ear in the previous procedure.  

4. Access Enterprise Manager (EM) at:  

http://host:port/em 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-5.) 

5. From the left navigator and under your domain, expand SOA and right-click on 

soa-infra. 

6. Select SOA Deployment → Deploy. 

7. Under Archive or Exploded Directory, select the radio button for Archive on the 

server where Enterprise Manager is running. Enter 

<temp>/sca_grcclientcomposite.jar. Under Configuration Plan, select Configuration 

plan is on the server where Enterprise Manager is running, and enter 

<temp>/grcclient-composite-cfgplan.xml. Then click Next. 

8. On the Select Target page, select the partition in which to deploy this SOA com-

posite application. Even if only one partition is available, you must explicitly select 

it. A partition named default is automatically included with Oracle SOA Suite. 

9. Review your selections on the Confirmation page, and select to deploy the SOA 

composite as the default revision. The default revision is instantiated when a new 

request comes in.  

10. Click Deploy. Processing messages are displayed. 

When deployment has completed, the home page of the newly deployed composite 

revision appears automatically. A confirmation message at the top of the page tells 

you that the composite has been deployed successfully. 

If you need to deploy composites again at a later point, first undeploy composites, 

then use the procedure defined above to deploy again. To undeploy composites: 

1. Log on to Enterprise Manager (see step 4 above).  

2. From the left navigator and under your domain, expand SOA and right-click on 

soa-infra. 



 

2-12 Oracle Enterprise Governance, Risk and Compliance Installation Guide 

3. Select SOA Deployment → Undeploy. 

4. Click Undeploy. 

Creating Keystores 

If you are installing GRC with SOA, or to run with a pre-existing SOA, create 

“keystores” once SOA composites exist. (If you are installing GRC without SOA, this 

does not apply; skip ahead to “WebLogic Console Configuration” on page 2-14.) 

1. Stop the (newly created or pre-existing) SOA Server and the Administration 

Server. 

2. Use keytool to set up your keystore. (Keytool is located in <Java_Home>/bin, 

where <Java_Home> represents the highest-level directory in which Java com-

ponents are installed.) Execute the following command: 

./keytool -genkeypair -alias orakey -keyalg "RSA" -keystore 

default-keystore.jks -validity 3600 

3. When prompted, designate a keystore password and a key password. This cre-

ates a keystore called default-keystore.jks, and a key pair with the alias orakey 

within that keystore.  

4. Move the new keystore to a directory called fmwconfig. Execute this command: 

mv default-keystore.jks 

<MW_HOME>/user_projects/domains/<grc_domain>/config/fmwconfig 

This overwrites a pre-existing default-keystore.jks file.  

5. Start the Administration Server and the SOA Server. 

Setting Up Credentials 

If you are installing GRC with SOA, or to run with a pre-existing SOA, use 

Enterprise Manager (EM) to set up credentials once keystores are created. (If you 

are installing GRC without SOA, this does not apply; skip ahead to “WebLogic 

Console Configuration” on page 2-14.) 

1. Access EM at 

http://host:port/em 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-5.) 

2. Click on Weblogic Domain → <grc_domain>. 

3. Right-click on the <grc_domain> and select Security → Credentials. 

4. On the Credentials page, click on the button labeled + Create Map. Enter 

oracle.wsm.security as Map Name, and click OK. A new row, oracle.wsm.security, 

is created. 

5. Add keys to the wallet. For each key, click the button labeled + Create Key, 

then supply the following values in response to prompts: 

• basic.credentials (this contains user authentication) 

– Select Map: oracle.wsm.security 

– Key: basic.credentials 
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– Type: Password 

– Username: weblogic 

– Password: weblogic 

– Description: User credentials key 

• keystore-csf-key 

– Select Map: oracle.wsm.security 

– Key: keystore-csf-key 

– Type: Password 

– Username: owsm 

– Password: Enter the keystore password you created in step 3 of 

“Creating Keystores” (above). 

– Description: Keystore key 

• enc-csf-key 

– Select Map: oracle.wsm.security 

– Key: enc-csf-key 

– Type: Password 

– Username: orakey 

– Password: Enter the key password you created in step 3 of “Creating 

Keystores” (page 2-12). 

– Description: Encryption key 

• sign-csf-key 

– Select Map: oracle.wsm.security 

– Key: sign-csf-key 

– Type: Password 

– Username: orakey 

– Password: Enter the key password you created in step 3 of “Creating 

Keystores” (page 2-12). 

– Description: Signing key 

When you finish creating credentials, your domain should be running with at least 

the Administration Server and SOA Server. 

Creating the SOA Admin User and Enabling Embedded LDAP 

If you are installing GRC with SOA, or to run with a pre-existing SOA, create a user 

called soaadmin and enable Embedded LDAP. (If you are installing GRC without SOA, 

this does not apply; skip ahead to “WebLogic Console Configuration” on page 2-14.) 

1. Shut down the SOA Server. (If you are installing GRC with SOA, this is the 

managed server discussed in step 8 of “Creating a WebLogic Domain,” page 2-5. 

If you are installing GRC to run with a pre-existing SOA instance, this is the 

SOA server created for that instance.) 
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2. Log in to the WebLogic Server Administration Console at 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-
ating a WebLogic Domain” on page 2-5.) 

3. Click on Security Realms, then myrealm. Click Users and Groups. Click New, 

and enter soaadmin in the Name field. Add a description. Accept “Default 

Authenticator.” Enter a password of your choice in the Password field, and the 
same value in the Confirm Password field. Click Save. 

4. Click on the soaadmin user. Click on the Groups tab, and move the value 

Administrators from Available to Chosen. Then save your settings. 

5. Click on <grc_domain>. Click the Security tab, then Embedded LDAP. Enter 

any value for Credential, and then the same value for Confirm Credential.  

6. Stop and start the Administration Server. 

WebLogic Console Configuration 

For any installation, use the WebLogic Server Administration Console to complete 
additional configuration steps: 

1. Make sure you are logged in to the WebLogic Console (see step 2 of “Creating 

the SOA Admin User and Enabling Embedded LDAP,” page 2-13). 

2. In the Change Center pane, click Lock & Edit. 

3. In the Domain Structure pane, click on Deployments. 

4. In the Summary of Deployments pane, select the Control tab. 

5. In the Summary of Deployments pane, click on the Install button. 

6. In the Path field of the Install Application Assistant pane, enter the full path to 

the grc864 directory you created earlier (see step 3 of “Preparing Additional 

Files” on page 2-5). Select “grc864 (open directory)” under Current Location. 

7. In the Install Application Assistant pane, press next.  

8. In the Install Application Assistant pane, choose Install this deployment as an 
application in the “Choose targeting style” section. 

9. In the Install Application Assistant pane, press Next. Then: 

• If you are installing GRC to run FAACG, select the GRC managed server 
you created in step 8 of “Creating a WebLogic Domain” (page 2-5). 

• If you are installing GRC with SOA, select the Administration Server.  

• If you are installing GRC to run without SOA or with a pre-existing SOA, you 
are not presented with an opportunity to select a server here. Skip to step 10.  

10. In the Install Application Assistant pane, choose I will make this deployment 

accessible from the following location in the “Source accessibility” section. 
Accept all other defaults. 

11. In the Install Application Assistant pane, press Next. 

12. In the Install Application Assistant pane, choose Yes, take me to the deploy-

ment’s configuration screen in the “Additional configuration” section. 
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13. In the Install Application Assistant pane, press Finish. 

14. In the Install Application Assistant pane, press Save, then Activate Changes. On 

the Deployments screen, the state of the grc864 application will be Prepared.  

15. Select the grc864 application. Click Start, select Servicing all requests, click Yes on 

Start Application Assistant,  and wait until the application status changes to Active. 

Modifying Settings 

Next, modify settings in a file called setDomainEnv.sh, which is located in the 

<MW_HOME>/user_projects/domains/<grc_domain>/bin directory.  

1. Stop the SOA Server (if you are installing EGRCM with SOA) and the 

Administration Server.  

2. Navigate to setDomainEnv.sh and open it in a text editor.  

3. In the file, locate the following lines: 

# IF USER_MEM_ARGS the environment variable is set, use it 

to override ALL MEM_ARGS values 

if [ "${USER_MEM_ARGS}" != "" ] ; then 

4. Insert the following lines between those two lines:  

case "${SERVER_NAME}" in 

"AdminServer") 

  USER_MEM_ARGS="-Xms4g –Xmx16g" 

;; 

"bi_server1") 

  USER_MEM_ARGS="-Xms2g –Xmx8g" 

;; 

"soa_server1") 

  USER_MEM_ARGS="-Xms2g –Xmx4g" 

;; 

"sample_server1") 

  USER_MEM_ARGS="-Xms4g -Xmx16g" 

;; 

"sample_server2") 

  USER_MEM_ARGS="-Xms4g -Xmx16g" 

;; 

*) 

  echo "Unknown Server Detected!!. Memory set as Xms1g 

Xmx2g."; 

USER_MEM_ARGS="-Xms1g -Xmx2g" 

;; 

esac 

USER_MEM_ARGS="${USER_MEM_ARGS} -XX:PermSize=256m 

-XX:MaxPermSize=512m -XX:ReservedCodeCacheSize=128M 

-Djava.awt.headless=true -Djbo.ampool.maxpoolsize=600000" 

Replace “placeholder” names (AdminServer, bi_server1, soa_server1, 

sample_server1, and sample_server2) with the names of your Administration 

Server and any managed servers included in your installation. 

You may use a maximum memory setting (-Xmx) larger than 16G if your server 

has enough memory to support the larger value.  
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5. Locate the following section of the file and ensure that “-da” appears after each 

of two “${enableHotSwapFlag}” elements: 

if [ "${debugFlag}" = "true" ] ; then 

JAVA_DEBUG="-Xdebug -Xnoagent 

-Xrunjdwp:transport=dt_socket,address=${DEBUG_PORT},server

=y,suspend=n -Djava.compiler=NONE" 

export JAVA_DEBUG 

JAVA_OPTIONS="${JAVA_OPTIONS} ${enableHotswapFlag} -da 

-da:com.bea... -da:javelin... -da:weblogic... 

-ea:com.bea.wli... -ea:com.bea.broker... 

-ea:com.bea.sbconsole..." 

export JAVA_OPTIONS 

else 

JAVA_OPTIONS="${JAVA_OPTIONS} ${enableHotswapFlag} -da" 

export JAVA_OPTIONS 

fi 

6. Locate the EXTRA_JAVA_PROPERTIES section of the file. In it, remove the 

following string: 

-Dorg.apache.commons.logging.Log=org.apache.commons.logging.

impl.Jdk14Logger 

7. Save and close the file. Start the Administration Server and (if appropriate) 

SOA Server. 

Setting Up Tomcat Application Server  

If you prefer to use Tomcat Application Server rather than WebLogic, disregard all 

the WebLogic information on pages 2-3 through 2-16, and complete this section instead. 

Then, if your GRC database supports RAC, continue at “Installing a Driver for RAC,” 

or if it does not, continue at “GRC Configuration.” Both appear on page 2-18. 

To install or upgrade GRC with Tomcat: 

1. For a fresh installation, download and install Tomcat generally as its documen-

tation instructs you to do.  

2. Shut down the Tomcat application server. 

3. If you are upgrading, remove the directory <TomcatHome>/webapps/grc, and 

all its contents. If you are performing a new installation, this subdirectory does 

not exist; skip this step.  

Note: Throughout this document, replace the value <TomcatHome> with the full 

path to the highest-level directory in which Tomcat components are installed. 

If you are upgrading, also remove the grc directory from the Tomcat work area 

(<TomcatHome>/work/Catalina/localhost/grc). Also delete Tomcat logs, located 

at <TomcatHome>/logs (you may want to save them to another location first). 
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4. If you are upgrading from version 8.6.4.4240, navigate to 

<TomcatHome>/webapps and, from it, delete the file grc.war. If you are 

performing a new installation of GRC 8.6.4.5000, ignore this step. 

5. Modify Tomcat settings. In <TomcatHome>/bin, create the file setenv.sh. If you 

do not intend to use FAACG, include the following lines in setenv.sh: 

CATALINA_OPTS="-Xss512k -Xms256M –Xmx16G -XX:MaxPermSize=256m 

-XX:+UseParallelGC -Djava.awt.headless=true 

-XX:-UseGCOverheadLimit -XX:ReservedCodeCacheSize=128M" 

export CATALINA_OPTS 

If you intent to use FAACG, include the following lines in setenv.sh: 

CATALINA_OPTS="-Doracle.security.jps.config=<TomcatHome>/bin/

config/jps-config.xml -Xss512k -Xms256M –Xmx16G 

-XX:MaxPermSize=256m -XX:+UseParallelGC -Djava.awt.headless=true 

-XX:-UseGCOverheadLimit -XX:ReservedCodeCacheSize=128M" 

export CATALINA_OPTS 

You may use a maximum memory setting (-Xmx) larger than 16G if your server 

has enough memory to support the larger value. 

6. Edit <TomcatHome>/conf/catalina properties. Locate the common.loader line 

and set it as follows: 

common.loader=${catalina.home}/lib/adf,${catalina.home}/lib

/adf/*.jar,${catalina.base}/lib,${catalina.base}/lib/*.jar,

${catalina.home}/lib,${catalina.home}/lib/*.jar 

7. Navigate to <grc_stage>/dist. From there, run the file grc_tomcat_setup.sh 

Supply the paths to <grc_stage>/dist subdirectory, <TomcatHome>, and the full 

path to your Java home as parameters: 

cmd> ./grc_tomcat_setup.sh <grc_stage>/dist <TomcatHome> 

JavaHomePath 

8. Start the Tomcat application server. 

Installing a Driver for RAC 

If your GRC database is one in which Real Application Clusters (RAC) is enabled, 

you need to set up a jdbc-oci driver, which is used for the connection between GRC 

and the RAC database. (If you do not use RAC, this section does not apply to you; 

skip ahead to the next section, “GRC Configuration.”) 

1. Shut down your web application server (WebLogic administration server and, if 

installed, SOA server; or Tomcat application server).  

2. In a web browser, go to http://www.oracle.com/technetwork/database/features/ 

instant-client/index-097480.html. Select the Instant Client link for the platform 

on which you are installing, then find the Basic download for 11.2.0.1.0. 

3. Download and unzip the package into a single directory, such as “instantclient.”  

4. Set the library loading path in your environment to this directory before starting 

the application. On many Linux platforms, LD_LIBRARY_PATH is the appropri-

ate environment variable. 
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5. Copy the file ojdbc6.jar from the instant client to <TomcatHome>/webapps/grc/ 

WEB-INF/lib if you installed GRC to run with Tomcat, or to grc864/grc/WEB-INF/lib 

if you installed GRC to run with WebLogic. (In the latter case, you created grc864 

as a home directory for your GRC installation in step 3 of “Preparing Additional 

Files” on page 2-5.) 

6. Restart your web application server.  

GRC Configuration 

Regardless of whether you use WebLogic or Tomcat, open a Manage Application 

Configurations page to perform GRC-specific configuration: 

1. Access GRC at 

http://host:port/grc 

In this URL, replace host with the FQDN of your GRC server. Select one of the 

following values for port: 

• If you use WebLogic and are installing GRC to run FAACG, enter the port 

number you chose for the GRC managed server as you created a WebLogic 

domain. (See step 8 of “Creating a WebLogic Domain” on page 2-5.) 

• If you use WebLogic and are performing any other installation, enter the port 

number you chose for the Administration Server as you created a WebLogic 

domain. (See step 7 of “Creating a WebLogic Domain” on page 2-5.) 

• If you use Tomcat, replace port with 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

2. A ConfigUI page appears. In the Installation Configuration section, type or select 

appropriate property values: 

• User Name: Supply the user name for the GRC database. 

• Password: Supply the password for the GRC database.  

• Confirm Password: Re-enter the password for the GRC database.  

• Port Number: Supply the port number at which the GRC database server 

communicates with other applications.  

• Service Identifier: Supply the service identifier (SID) for the GRC database 

server, as configured in the tnsnames.ora file. Or, if your GRC database sup-

ports RAC, enter the RAC service name configured for your RAC database.  

• Server Name: Supply the FQDN of the database server. Or, if your GRC 

database supports RAC, enter RAC@<SCAN_NAME>, where <SCAN_ 

NAME> is the IP address/host name of the SCAN address configured for 

your RAC database.  

• Maximum DB Connections: Default is 50. You can edit this value. 

• Report Repository Path: Supply the full path to the Report Repository 

directory discussed in “Creating GRC Repositories” on page 2-3.  
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• Log Threshold: Select a value that sets the level of detail in log-file entries. 

From least to greatest detail, valid entries are error, warn, info, and debug.  

• Transaction ETL Path: Enter the full path to the directory you created to 

hold ETL data used by Enterprise Transaction Controls Governor (see 

“Creating GRC Repositories” on page 2-3). 

• App Server Library Path: Enter the full path to the library subdirectory of 

your web application server (for use in the upload of custom connectors for 

AACG). If you are installing GRC to run FAACG, set this value to 

<grc864>/grc/WEB-INF/lib. 

3. In the Language Preferences section of the ConfigUI page, select the check 

boxes for up to twelve languages in which you want GRC to be able to display 

information to its users.  

4. In the Performance Configuration section of the ConfigUI page, select or clear 

check boxes: 

• Optimize Distributed Operation: Select the check box to increase the speed 

at which GRC performs distributed operations such as data synchronization.  

• Optimize Appliance-Based Operation: Select the check box to optimize 

performance if the GRC application and GRC schema reside on the same 

machine. Do not select this check box if the GRC application and schema 

do not reside on the same machine. When you select this check box, an 

ORACLE_HOME Path field appears. In it, enter the full, absolute path to your 

Oracle Home — the directory in which you have installed the Oracle data-

base that houses the GRC schema. 

• Enable Era-Based ETL Optimization: “Data synchronization” enables both 

ETCG and AACG to recognize data changes in the business applications 

subject to their models and controls. For ETCG only, select this check box 

to cause synchronization to operate only on data entered in business applica-

tions after a specified date.  

When you select this check box, an Analysis Start Date field appears. In it, 

enter a date from which you want synchronization runs to recognize data 

changes. When you click in the field, a pop-up calendar appears. Click left- 

or right-pointing arrows to select earlier or later months (and years), and 

then click on a date in a selected month. 

• Externalize Report Engine: Select the check box to enable the reporting 

engine to run in its own java process, so that the generation of large reports 

does not affect the performance of other functionality. However, select the 

check box only if you have installed GRC on hardware identified as “certi-

fied” in the Oracle Enterprise Governance, Risk and Compliance Certifica-

tions Document; clear the check box if you use hardware identified as “sup-

ported.” 

• Enable Parallel Processing: Select this check box to enable multiple models 

and controls to be processed simultaneously. However, this feature requires, 

at minimum, 16 GB of RAM; 24 GB is preferred. 

When you select the Enable Parallel Processing check box, two fields appear. 

In a Number of Cores Available for Processing field, enter the number of 

processor cores you wish to devote to parallel processing; one core is devoted 
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to each model or control selected for analysis, until as many cores as you 

select are in use. In a Maximum Megabytes of Physical RAM Available field, 

specify an amount of memory for use in parallel processing. As a rule of 

thumb, enter total RAM minus 8 GB; you may need to adjust this value if 

other processes run slowly.  

• Enforce Allocated Analysis Time Per Filter: Select this check box, and 

enter a number in the Minutes field, to limit the time that transaction models 

and controls can run.  

A model or control consists of filters, each of which defines some aspect of 

a risk and selects transactions that meet its definition. When the Allocated 

Analysis Time feature is enabled, each filter runs no longer than the number 

of minutes you specify. If time expires, the filter passes records it has selected 

to the next filter for analysis, but ignores records it has not yet examined. So 

a filter may not capture every record that meets its definition, and the model 

or control results are labeled “partial” in GRC job-management pages.  

Once enabled here, this feature may be disabled for individual models (and 

for the controls developed from those models). This feature applies only to 

transaction models and controls, not to access models and controls, and not 

to EGRCM objects.  

5. In the ConfigUI page, click on Actions → Save. GRC tests the values you’ve 

entered and, if they are valid, saves them. (If any are invalid, an error message 

instructs you to re-enter them.) 

6. Exit the ConfigUI page.  

Completing the Installation 

With components in place and properly configured, complete the installation, in 

effect by running your web application server.  

1. Shut down your server — the Administration Server if you’re using WebLogic, 

or the Tomcat application server if you’re using Tomcat. Then restart the server. 

2. In a web browser, enter the GRC URL (see step 1 of “GRC Configuration” on 

page 2-18). 

3. Wait for a pop-up message to report, “Database upgrade and initialization process 

complete.” Click on its OK button. 

4. You are redirected to a GRC logon page. Log on to the application. For a fresh 

installation, use the default logon values admin for user ID and admin for 

password. GRC requires you to change the password the first time you log on. If 

you are upgrading, you can use the password established for the previous version.  

If you are installing GRC without SOA and have not set up an external OID LDAP 

repository to manage users, basic GRC installation is complete. (You may, however, 

choose to set up SSL, embed GRCI, or complete other procedures described later in 

this chapter and in following chapters.) 
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If you have installed GRC with SOA (or to run with a pre-existing SOA), or if you 

have set up an OID LDAP repository, complete some additional steps: 

1. If you use SOA, ensure that the SOA Server is up and running. (If you have 

installed GRC with SOA, the SOA Server is the managed server discussed in step 

8 of “Creating a WebLogic Domain,” page 2-5. If you have installed GRC to run 

with a pre-existing SOA instance, this is the SOA server created for that instance.) 

2. In GRC, select Navigator → Setup and Administration → Setup → Manage 

Application Configurations. 

3. If you need to configure SOA, select the Worklist tab and enter these values: 

• Worklist Server User Name: Keep the default value, soaadmin. 

• Worklist Server Password. Enter the password you created for the soaadmin 

user (see step 3 of “Creating the SOA Admin User and Enabling Embedded 

LDAP” on page 2-13). 

• Worklist Server Confirm Password: Re-enter the Worklist Server Password. 

• Worklist Server URL: http://host:port, in which host is the IP address of your 

SOA server, and port is its port number.  

• Worklist Server Protocol: Select the communications protocol —SOAP or 

RMI — used by the GRC application to send and receive SOA requests.  

4. If you need to configure external OID LDAP, select the User Integration tab and 

enter the following values: 

• Enable Single Sign On: Select the check box to make use of Single Sign 

On, which establishes a single set of log-on credentials for each user in 

varying applications. (Or, clear the check box if you do not wish to use 

Single Sign On.) 

• Enable Integration: Select the check box to permit integration with LDAP to occur. 

• User Name: Supply the user name (common name) to log in to the LDAP 

server. This user should have admin privileges. (This is the value specified 

for “Principal” in step 7 of “Configuring External OID LDAP,” page 2-6.) 

• Password: Enter the password for the user identified in the User Name field 

(established in step 7 of “Configuring External OID LDAP”). 

• Confirm Password: Re-enter the password for the user identified in the User 

Name field. 

• Port Number: Enter the port number at which the LDAP server communi-

cates with other applications (established in step 7 of “Configuring External 

OID LDAP”). 

• Server Name: Enter the host name of the LDAP server. (This is the “Host” 

value from step 7 of “Configuring External OID LDAP.”) 

• Bind DN Suffix: Enter the “User Base DN” from step 7 of “Configuring 

External OID LDAP.” 

• Enable SSL Authentication: Select the box to allow GRC to access the LDAP 

server through SSL. The LDAP server must be configured to support SSL. 
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• Perform LDAP Recursive Search: Select the check box to search recursively 

for users in subfolders along with those in the base path specified in the Bind 

DN Suffix field. 

• Unique User Identifier: uid 

5. In the Manage Application Configurations page, click on Actions → Save. Then 

log off of GRC. 

6. Stop the GRC Deployment in the WebLogic Console: 

a Log in to the WebLogic Console at  

http://host:port/console 

Replace host with the FQDN of your GRC server, and port with the number 

you selected for the WebLogic Administration Server. (See step 7 of “Creating 

a WebLogic Domain” on page 2-5.) 

b From the Domain Structure menu, select Deployments. 

c From the Deployment page, locate the GRC deployment and verify the state 

is Active. 

d Click the checkbox next to the GRC deployment. 

e From the toolbar, click Stop → Force Stop Now. 

7. Start the GRC Deployment in the WebLogic Console: 

a From the Domain Structure menu, select Deployments. 

b From the Deployment page, locate the GRC deployment and verify the state 

is Prepared. 

c Click the checkbox next to the GRC deployment. 

d From the toolbar, click Start → Servicing All Requests. 

GRC and SSL 

Once GRC in installed, you can set it up to support Secure Sockets Layer (SSL). 

This is a prerequisite if you intend to use Application Access Controls Governor, 

and intend to install preventive enforcement agents (PEAs) to support SSL. (For 

more on PEAs, see chapter 7.) Otherwise, GRC support for SSL is optional. The 

procedure you use depends on whether you have installed GRC to run with 

WebLogic or Tomcat.  

Implementing SSL if GRC Runs with WebLogic 

To install and configure SSL support for a GRC instance that runs with WebLogic, 

first create custom certificates, then enable and configure SSL.  

To create custom certificates: 

1. Navigate to the config directory of your WebLogic domain — 

<MW_HOME>/user_projects/domains/<grc_domain>/config. 
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2. Create a self-signed keystore. Run the following command. (Here and throughout 

this section, replace <Java_Home> with the full path to the highest-level direc-

tory in which Java components are installed.) 

<Java_Home>/bin/keytool -genkey -alias grc -keyalg RSA 

-keysize 1024 -dname "CN=KeyMachine,OU=Unit, O=Org, 

L=Locality, ST=StateProvince, C=CountryCode" -keypass 

KeyPassword -keystore KeyFileName.jks -storepass StorePassword 

In this command, replace italicized values as follows (and enter other values as 

they are shown). 

• -alias: Accept grc, or enter any other value. (If you choose a value other 

than grc, be sure to use that same value where you need to supply the alias 

in subsequent commands in this procedure.) 

• -dname parameters: 

CN stands for Common Name. Replace KeyMachine with the fully quali-

fied domain name of the machine on which the keystore is being generated 

(the GRC server). 

OU and O: Replace Unit with the name of an organizational unit, and Org 

with the name of the parent organization of that unit. You can supply any 

values you choose. 

L, ST, and C: Replace Locality with the name of a city or municipality; 

StateProvince with the name of a state, province, or other political subdivi-

sion of a country; and CountryCode with a two-letter country code.  

• -keypass and -storepass: Replace KeyPassword and StorePassword with 

passwords that you create as you run this command. It’s recommended that 

you use the same value for both passwords. (These values, established here, 

will be used in subsequent commands.)  

• -keystore: Replace KeyFileName with any name for a keystore file. (The file 

extension must be .jks, and the name, established here, will be used in subse-

quent commands.) 

3. Self-sign the certificate. Run the following command.  

<Java_Home>/bin/keytool -selfcert -v -alias grc -keypass 

KeyPassword -validity 8000 -keystore KeyFileName.jks 

-storepass StorePassword -storetype jks 

Again, replace italicized values as follows (and enter other values as they are 

shown). 

• -alias: Replace grc with the alias you created in step 2 (or use grc if you 

accepted that value in step 2). 

• -keypass and -storepass: Replace KeyPassword and StorePassword with the 

passwords you created in step 2.  

• -keystore: Replace KeyFileName with the keystore file name you created in 

step 2.  

4. Export the root certificate. Run the following command: 

<Java_Home>/bin/keytool -export -v -alias grc -keystore 

KeyFileName.jks -storepass StorePassword -file rootCA.der 
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Again, replace italicized values as follows (and enter other values as they are 

shown). 

• -alias: Replace grc with the alias you created in step 2 (or use grc if you 

accepted that value in step 2). 

• -keystore: Replace KeyFileName with the keystore file name you created in 

step 2. 

• -storepass: Replace StorePassword with the password you created in step 2.  

• -file: Replace rootCA with a file name of your choosing. (The file extension 

must be .der, and the name, established here, will be used in a subsequent 

command.) 

5. Import the root certificate into a trusted keystore. Run the following command: 

<Java_Home>/bin/keytool -import -v -trustcacerts -alias grc 

-keystore trust.jks -storepass StorePassword -file rootCA.der 

Again, replace italicized values as follows (and enter other values as they are 

shown): 

• -alias: Replace grc with the alias you created in step 2 (or use grc if you 

accepted that value in step 2). 

• -keystore: Replace trust with a new keystore name. This must not be the 

same as the -keystore value entered in earlier steps, but otherwise may be 

any value you wish. (The file extension must be .jks.)  

• -storepass: Replace StorePassword with the password you created in step 2. 

• -file: Replace rootCA with the file name you created in step 4. (The file 

extension must be .der.) 

When prompted “Trust this certificate? [no],” enter yes to confirm the key import. 

To enable SSL: 

1. Log in to the WebLogic Server Administration Console at 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-5.) 

2. In the left panel of the Console, expand Environment and select Servers. 

3. Click the name of the Administration Server on which GRC is installed. 

4. In the Change Center of the Administration Console, click Lock & Edit. 

5. Select the Configuration tab and then the General subtab. 

6. Select the checkbox next to SSL Listen Port Enabled. 

7. Enter a port number in the SSL Listen Port textbox. 

8. Select Save. Click Activate Changes in the Change Center of the Administration 

Console. 
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To configure SSL: 

1. Still in the Administration Console, expand Environment and select Servers. 

2. Click the name of the Administration Server on which GRC is installed. 

3. In the Change Center of the Administration Console, click Lock & Edit. 

4. Select the Configuration tab and then the Keystores subtab. 

5. In the Keystore row, click the Change button. From the drop-down list, select 

Custom Identity and Custom Trust. 

6. In the Custom Identity Keystore field, enter the full path to your keystore file 

(the .jks file you created at step 2 in the procedure for creating custom certifi-

cates, page 2-23).  

7. Enter JKS as the value for Custom Identity Keystore Type. 

8. For the Custom Identity Keystore Passphrase, enter the value you chose for the 

-storepass parameter at step 2 in the procedure for creating custom certificates 

(page 2-23). 

9. Re-enter the -storepass value in the Confirm Custom Identity Keystore Pass-

phrase field.  

10. In the Custom Trust Keystore field, enter the full path to your trusted keystore 

file (the .jks file you created at step 5 in the procedure for creating custom cer-

tificates, page 2-24). 

11. Enter JKS as the value for Custom Trust Keystore Type. 

12. For the Custom Trust Keystore Passphrase, enter the value you chose for the 

-storepass parameter at step 5 in the procedure for creating custom certificates 

(page 2-24). 

13. Reenter the -storepass value in the Confirm Custom Trust Keystore Passphrase field. 

14. Select Save. Click Activate Changes in the Change Center of the Administration 

Console.  

15. In the Change Center of the Administration Console, click Lock & Edit. 

16. Click on the SSL subtab, to the right of the Keystore subtab. 

17. Ensure that the Identity and Trust Locations value is set to “Keystores.” If not, 

change it to this value.  

18. Set the value of the Private Key Alias to the value you chose for the -alias 

parameter at step 2 in the procedure for creating custom certificates (page 2-23). 

19. For the Private Key Passphrase, enter the values you chose for the -keypass 

parameter at step 2 in the procedure for creating custom certificates (page 2-23). 

20. Reenter that -keypass value in the Confirm Private Key Passphrase field. 

21. Expand the Advanced options of the SSL subtab by clicking on the Advanced 

pane title. 

22. Select the Use JSSE SSL checkbox. 

23. Select Save. Click Activate Changes in the Change Center of the Administration 

Console. 
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24. Log out of the WebLogic Administration Console: click on the Log Out link at 

the top of the console page. 

25. Bounce the Administration Server, then ensure there are no SSL-related errors 

in the server log. 

26. Navigate to https://host:SSLport/console to test your latest changes. (The 

SSLport is the value you selected in step 7 of the procedure for enabling SSL, 

page 2-24.) 

Implementing SSL if GRC Runs with Tomcat 

To install and configure SSL support for a GRC instance that runs with Tomcat, 

prepare a certification keystore, then modify a server.xml file.  

To prepare the certification keystore, which contains a single self-signed certificate: 

1. Execute the following command from a terminal command line.  

<Java_Home>/bin/keytool -genkey -alias grc -keyalg RSA 

-keystore <TomcatHome>/conf/keystore -storetype pkcs12 

This command creates a new file, named “keystore,” in the conf directory of 

your <TomcatHome>. 

2. In response to a prompt, create a keystore password. (Note that you will need to 

specify this password later as you edit the server.xml file.) 

3. In response to a prompt, confirm the password you just created. 

4. In response to prompts, provide general information about the certificate, such 

as company, contact name, and so on. (This information is displayed to users 

who attempt to access a secure page in your application.) 

To modify the server.xml file: 

1. Navigate to <TomcatHome>/conf, and open the server.xml file for editing. 

2. In the file, locate a Connector element that looks like the following: 

<!-- Define a SSL HTTP/1.1 Connector on port 8443 

This connector uses the JSSE configuration, when using 

APR, the connector should be using the OpenSSL style 

configuration described in the APR documentation --> 

<!-- 

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLS" /> 

--> 

3. From the second block of text, delete the comment tags (<!-- and -->).  

4. Accept the default value for the port attribute (8443), or change it to any other 

value. This is the TCP/IP port number on which Tomcat listens for secure con-

nections. Note that special setup (outside the scope of this document) is neces-

sary to run Tomcat on port numbers lower than 1024 on many operating systems. 
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If you change the port number, also change the value for the redirectPort attribute 

on the non-SSL connector you use. This lets Tomcat redirect users who attempt 

to access a page with a security constraint specifying that SSL is required. 

5. Add values to the connector element — keystoreFile, keystorePass, keyAlias, 

and keystoreType attributes. A completed connector element looks like the 

following (in which you would replace YourKeystorePassword with the pass-

word you created as you prepared the certification keystore): 

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLS" 

keystoreFile="<TomcatHome>/conf/keystore" 

keystorePass="YourKeystorePassword" keyAlias="grc" 

keystoreType="PKCS12" /> 

6. Restart Tomcat.  

Accessing GRC 

After configuring SSL successfully, access the GRC application at 

https://host:SSLport/grc, in which host is the FQDN of your GRC server, and 

SSLport is the port you selected to support SSL. (If you use WebLogic, see step 7 

on page 2-24. If you use Tomcat, see step 4 above.) 

Because you are using a self-signed certificate, which is not signed by an official 

Certificate Authority, you get a security warning when you open GRC at this URL.  

• For Internet Explorer, the warning reads, "There is a problem with this 

website’s security certificate.” Dismiss this warning by choosing “Continue to 

this website (not recommended).” 

• For Firefox, the warning reads, “This Connection is Untrusted.” Dismiss this 

warning by clicking “I Understand the Risks,” and then “Add Exception.”  
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Integrating GRCI 

If you intend to license GRCI for use with GRC, complete the procedures described 

in this chapter.  

In very broad terms, the GRCI integration is a three-step process: 

• You are assumed to have created a Data Analytics (DA) schema for use by 

GRCI (see “Creating GRC and DA Schemas,” page 1-3). Set up connections to 

the DA schema in a GRC Analytics page. 

• GRCI makes use of Oracle Business Intelligence Enterprise Edition (OBIEE), 

so you need to set up OBIEE for use with GRC. 

• Select and optionally rename GRCI dashboards that are to appear in the GRC 

instance. 

If you’ve installed GRC with WebLogic, you can embed your GRCI instance within 

GRC. If you’ve installed GRC with Tomcat, you must install OBIEE (and so GRCI) 

as a standalone application.  

Connecting to the DA Schema 

The GRC schema used by GRC supplies data to the DA schema used by GRCI. For 

this to happen, you need to enter connectivity information in GRC.  

1. Log on to GRC (see step 1 of “GRC Configuration” on page 2-18). Select Navi-

gator → Tools → Setup and Administration → Setup → Manage Application Con-

figurations → Analytics. 

2. In the Data Analytics Configuration section, enter values that identify the DA 

schema you set up in “Creating GRC and DA Schemas” (page 1-3). 

• User Name: Supply the user name for the DA database. 

• Password: Supply the password for the DA database. 

• Confirm Password: Re-enter the password for the DA database. 

• Port Number: Supply the port number at which the database server 

communicates with other applications. 
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• Service Identifier: Supply the service identifier (SID) for the database 

server. 

• Server Name: Supply the fully qualified domain name of the database server. 

3. When you finish entering property values, click on Actions → Save. GRC tests 

the values you’ve entered and, if they are valid, saves them. (If any are invalid, 

an error message instructs you to re-enter them.) 

4. Look for the prompt, “Successfully saved configuration values.”  

After that message appears, a one-time process runs in the background. It creates the 

DA schema tables and views. This process takes approximately fifteen minutes. Do 

not stop your WebLogic or Tomcat server during this period.  

Once you have connected to the DA schema, set a schedule on which the schema is 

refreshed — on which the DA schema reads from the GRC schema. No data exists in 

the schema until the first scheduled refresh occurs. You can modify a schedule at any 

time. (A refresh can take up to 90 minutes to finish.) To create the schedule:  

1. Select the Analytics tab of the Manage Applications Configurations page.  

2. Click on the Schedule Data Analytics Update button.  

3. A Schedule Parameter dialog opens. Enter values that set the name of the sched-

ule, its start date and time, the regularity with which the DA schema should be 

refreshed, and an end date (if any). Then click on the Schedule button.  

4. Click on Actions → Save.  

To view the status of a scheduled refresh, go to Tools → Setup and Administration 

→ Manage Jobs. To view the Data Analytics schedule, go to Tools → Setup and 

Administration → Manage Scheduling.  

Setting Up OBIEE in GRC with WebLogic 
If you installed GRC to run with WebLogic, complete procedures documented from 

here to page 3-7. Then skip “Setting Up OBIEE in GRC with Tomcat,” and continue 

at “Repository and WebCat Configuration ” on page 3-9. 

Ensure that the Administration Server and (if one was created) the managed server 

for your WebLogic domain are shut down. (See steps 7 and 8 on page 2-5.) Ensure 

that a VNC server is running on your GRC host (the machine on which you installed 

GRC in Chapter 2), and use a VNC client of your choosing to start a VNC session.  

Perform the OBIEE installation on the GRC host. 

Preparing Files 

Locate the files grc864_5259_OBIEE_1of3.tar.gz, grc864_5259_OBIEE_2of3.tar.gz, 

and grc864_5259_OBIEE_3of3.tar.gz  in your <grc_stage> directory (see “Down-

loading Files,” page 2-2). Extract their contents in <MW_HOME> (which, as noted in 

Chapter 2, represents the full path to the home directory of your middleware instal-

lation). This overwrites some files under the oracle_common directory. 
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Running the Installation Script 

If you installed GRC to run with WebLogic, run an installation script, which 

prompts you for settings that apply to your instance. The entire process is logged to 

<MW_HOME>/installation.log. 

Pay attention to script output on your monitor. Some installation stages may cause 

errors or may require your attention. Should errors occur, check the log file. Also, 

refer to “Troubleshooting” (page 3-13). 

To run the script, in <MW_HOME> execute: 

./install_obiee.sh 

The script reminds you to shut down your administration and managed servers. 

Also, it informs you about enabling X Display System in case you are interested in 

using a graphical user interface while performing a later installation step. 

Complete these steps:  

1. Type 1 and press Enter if you are ready to continue with setup. If, however, you 

need to shut down your servers or want to set up X Display, type 2 and press 

Enter to quit. 

2. Assuming you pressed 1 in step 1, you are asked if your GRC installation uses a 

SOA server. Type yes or no and press Enter. 

If you type yes, you are asked whether your SOA instance is installed on the 

domain where GRC is installed. Type yes or no, and press Enter. If you type 

yes, you are reminded to shut down your SOA server. Type ready and press 

Enter when it is shut down. 

3. Enter these values: 

• MW_HOME: The full path to the home directory of your middleware 

installation. 

• JAVA_HOME: The full path to the Java deployment used for the middleware 

installation (the JDK instance you confirmed to be in the path to install and 

run WebLogic under “Initial WebLogic Installation” on page 2-3.)  

• RCU_HOME: The full path to the highest-level directory in which RCU 

component exists.  

• DOMAIN: The full path to the WebLogic domain you created for GRC: 

<MW_HOME>/user_projects/domains/<grc_domain> (in which <grc_domain> 

represents the WebLogic domain name; see step 2 on page 2-4.) 

• ADMIN_SERVER_NAME: Your WebLogic Administration Server name. 

• If you indicated that you are using a SOA instance in step 2 above you will 

be asked for your SOA Server name. 

• HOST_PORT: The port number configured for your Administration Server 

(see step 7 on page 2-5.) 

• HOST: The fully qualified domain name for the GRC host — the machine on 

which you installed GRC in Chapter 2. 
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4. The script attempts to extract a few more values by using the settings you have 

already specified and also your current GRC installation. Verify that the follow-

ing values are detected correctly: 

• HOST_IP : The listen address assigned to the WebLogic domain on which 

GRC is installed. 

• DB_PORT : The port number at which the GRC database communicates with 

other applications. 

• DB_HOST : The fully qualified domain name for the machine that hosts the 

GRC database. 

• SID : the service identifier for the grc database server, as configured in the 

tnsnames.ora file. 

5. Enter these values: 

• DB_NAME: The fully qualified service name for the GRC database. 

• SYS_PASSWORD: The SYS user’s password for your GRC database 

installation. 

• WLS_ADMIN_USER: The administrator user name for your WebLogic 

installation. 

• WLS_ADMIN_PASSWORD: The administrator password for your WebLogic 

installation. 

6. The script performs string replacements inside installation files based on the 

setting values you’ve supplied, and it creates two RCU schemas. 

You are prompted to select if you would like to extend your WebLogic domain 

using a GUI wizard or in Console Mode. Type 1 for GUI mode or 2 for console 

mode, and then press Enter. 

7. Depending on your selection in step 6, follow instructions in either “Extending 

Your Domain in GUI Mode” (page 3-5) or “Extending Your Domain in Console 

Mode” (page 3-6). Then continue this procedure at step 8.  

8. Update the set DomainEnv.sh file as described in “Modifying Settings” on page 

2-15. 

9. The installation script continues to perform additional automated installation 

operations. If, in step 2, you indicated your SOA instance is installed on the 

GRC domain, the script attempts to start your SOA server. If not, start the SOA 

server. 

10. If you use SOA, you need to re-create SOA credentials. To do so, follow instruc-

tions in “Setting Up Credentials” on page 2-12.  

11. Complete the “Repository and WebCat Configuration” section (page 3-9) to 

update the rpd file with correct connection values. 

12. Complete the “Deploying GRCDiagnostic.rpd and Updating Scheduler 

Credentials” section (page 3-10). 

13. Test the installation to verify it was successful. See “Testing the Installation” 

(page 3-13). 
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Extending Your Domain in GUI Mode 

While install_obiee.sh is running, you are given the choice of using a GUI wizard or 

the console to extend the WebLogic domain you created for GRC. If you choose the 

GUI wizard and your system is set up correctly to run it, you follow these steps to 

extend your domain. 

If your system is not set up correctly, the wizard defaults to console mode. In that 

case follow the steps in “Extending Your Domain in Console Mode” (page 3-6). 

OWSM MDS and EPM schemas are the only two schemas you need to modify in 

the following steps.  

1. Select Extend an existing WebLogic domain. 

2. Click Next. 

3. Select to extend the <MW_HOME>/user_projects/domains/<grc_domain> 

directory. 

4. Click Next. 

5. Select Oracle BI Enterprise Edition. 

6. Click Next. 

7. Select both OWSM MDS and EPM schemas and enter the following values: 

• Vender: Oracle 

• DBMS/Service: The fully qualified service name for the GRC database. 

• Driver: Accept the default value. 

• Host Name: The fully qualified domain name for the machine that hosts the 

GRC database. 

• Schema Password: grc 

• Port: The port number at which the GRC database communicates with other 

applications. 

8. Unselect OWSM MDS Schema while leaving EPM Schema selected. As 

Schema Owner, enter the value EGRCM_BIPLATFORM. 

9. Unselect EPM Schema and select OWSM MDS Schema. As Schema Owner, 

enter the following value: EGRCM_MDS. 

10. Click Next. 

11. If the connection tests for both schemas succeed, click Next. Otherwise, click 

Previous and enter correct values. 

12. Select Managed Servers, Clusters and Machines. 

13. Click Next. 

14. Modify the Listen address field for bi_server1 to the IP address of the machine 

on which you installed GRC. 

15. Click Next. 
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16. Click Next. 

17. Click Next. 

18. Click Next. 

19. Click Extend. 

20. Click Done. 

Extending Your Domain in Console Mode 

If your system is not setup to display the GUI wizard or you would like to use the 

console mode, follow these steps to extend the domain. 

1. To select Extend an existing WebLogic domain, press 2. Then press Enter. 

2.  A list of available domains is displayed. To select the domain on which you 

installed GRC and are about to install OBIEE, enter the number proceeding the 

domain name on the list. Then press Enter. 

3. Enter 1 to choose WebLogic Platform Components. Then press Enter. 

4. Enter the number following the “Oracle BI Enterprise Edition — 11.1.1.6.0” 

component. Then press Enter. 

5. Press Enter to go to the next step. 

6. A list of two JDBC datasources appears. Enter 1 to modify the datasources and 

then press Enter. 

7. Press 1 and then Enter to modify the mds-owsm datasource. 

8. Press 4 to modify the Dbms name. Then press Enter. 

9. Enter your <DB_NAME> as the value. Then press Enter. 

10. Press 5 to modify the DBMS host. Then press Enter. 

11. Enter your <DB_HOST> as the value. Then press Enter. 

12. Press 6 to modify the DBMS port. Then press Enter. 

13. Enter <DB_PORT>. Then press Enter. 

14. Press 7 to modify the DBMS user name. Then press Enter. 

15. Enter EGRCM_MDS. Then press Enter. 

16. Press 8 to modify the user password. Then press Enter. 

17. Enter grc. Then press Enter. 

18. Press 9 to confirm the user password. Then press Enter. 

19. Enter grc. Then press Enter. 

20. Press Enter to accept your changes. 

21. Type 1 to modify another datasource. Then press Enter. 
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22. Type 2 to modify the EPMSystemRegistry datasource. Then press Enter. 

23. Press 4 to modify the DBMS name and then press Enter. 

24. Enter your <DB_NAME> as the value and then press Enter. 

25. Press 5 to modify the DBMS host. Then press Enter. 

26. Enter your <DB_HOST> as the value and then press Enter. 

27. Press 6 to modify the DBMS port. Then press Enter. 

28. Enter <DB_PORT>. Then press Enter. 

29. Press 7 to modify the DBMS user name. Then press Enter. 

30. Enter EGRCM_BIPLATFORM. Then press Enter. 

31. Press 8 to modify the user password. Then press Enter. 

32. Enter grc. Then press Enter. 

33. Press 9 to confirm the user password. Then press Enter. 

34. Enter grc. Then press Enter. 

35. Press Enter to accept your changes. 

36. Press Enter to continue. 

37. Enter 1 and then press Enter to select Managed Servers, Clusters and Machines. 

38. Press Enter to continue. 

39. Press 2 to modify a managed server. Then press Enter. 

40. Press 1 to modify bi_server1. Then press Enter. 

41. Press 2 to modify listen address. Then press Enter. 

42. Enter the IP address of the machine on which you installed GRC. Then press 

Enter. 

43. Press Enter. 

44. Press Enter. 

45. Press Enter. 

46. Press Enter. 

47. Press Enter. 

48. Make sure Yes is selected and press Enter, otherwise enter the row number for 

Yes and then press Enter followed by another Enter. 

Setting Up SOA Credentials 

During GRCI installation, a new cwallet.sso is installed. As a result, if you use SOA 

with your GRC installation you need to set up SOA credentials once again. To do 

so, follow instructions given in “Setting Up Credentials” on page 2-12. 
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Setting Up OBIEE in GRC with Tomcat 

If you installed GRC to run with Tomcat, disregard all the WebLogic information 

on pages 3-2 through 3-7, and complete this section instead. Then continue with 

“Repository and WebCat Configuration,” page 3-9. 

A GRC-Tomcat installation requires that you install OBIEE in a standalone config-

uration. Install OBIEE 11g Release 1 (11.1.1.6.0) and related components generally 

as their documentation instructs you to do.  

As you perform the installation, keep the following points in mind: 

• You will create RCU schemas to be used by OBIEE. As you do, use EGRCM as 

your schema prefix, and grc as the password for both the MDS and BIPLATFORM 

schemas. 

• Unless directed otherwise, accept default values. 

• Select Enterprise Install as your installation type. 

• On the screen titled Create or Scale Out BI System, select Create New BI 

System. Make a note of the username and password you choose. Accept the 

default domain name. 

• On the screen titled Specify Installation Location, set the Oracle Middleware 

Home path to the absolute path for your Oracle Middleware home. Specify either 

an empty directory or a directory that does not exist. (If the directory does not 

exist, the installer creates it for you.) Note the path to this directory; you will 

need it for a later configuration step. Throughout this document, <OBIEE_MW> 

will represent this path. Do not set the value for any other empty field; all will 

be populated based on your middleware home path.  

• On the port-configuration screen, specify ports appropriate for your environ-

ment, or accept the default ports. 

• Be sure to take note of paths and URLs displayed on a screen titled Installation 

Completed. You will need them later. These values include Oracle Enterprise 

Manager URL, Business Intelligence Enterprise Edition URL, and the port 

number used in the Business Intelligence Enterprise Edition URL.  

After installation is complete, shut down your Administration Server, BI Server, and 

BI components. Run the following commands: 

<OBIEE_MW>/user_projects/domains/bifoundation_domain/bin/stopM

anagedWebLogic.sh bi_server1 

<OBIEE_MW>/user_projects/domains/bifoundation_domain/bin/stopW

ebLogic.sh 

<OBIEE_MW>/instances/instance1/bin/opmnctl stopall 

Then, prepare files: 

1. Open <OBIEE_MW>/instances/instance1/config/OracleBIPresentationServices 

Component/coreapplication_obips1/instanceconfig.xml for editing. 

2. Locate the <Security> tag. On the line immediately below it, insert the 

following: 

<InIFrameRenderingMode>allow</InIFrameRenderingMode> 
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3. Save and close the instanceconfig.xml file. 

4. Copy tnsnames.ora from the Oracle database home for the database that hosts 

your DA schema (ORACLE_HOME/NETWORK/ADMIN/) to <OBIEE_MW>/Oracle_ 

BI1/network/admin. 

Repository and WebCat Configuration 

Extract and copy custom files that are consumed by GRCI dashboards and reports: 

• Locate the file grc-reportservices-8.6.4.5-SNAPSHOT-obiee-artifacts.zip in your 

<grc_stage>/dist directory (see “Downloading Files” on page 2-2). Extract its 

contents into a temporary directory. (Throughout this document, <OBIEE_TEMP> 

represents the full path to this directory.) 

• If your GRC installation uses Tomcat, copy <OBIEE_TEMP>/Webcat/GRCDWebcat 

to <OBIEE_MW>/instances/instance1/bifoundation/OracleBIPresentationServices 

Component/coreapplication_obips1/catalog. (Use the R option of the cp command.) 

• If your GRC installation uses WebLogic, copy 

<MW_HOME>/Webcat/GRCDWebcat to <OBIEE_MW>/instances/instance1/ 

bifoundation/OracleBI PresentationServicesComponent/coreapplication_obips1/ 

catalog. (Use the R option of the cp command.) 

Modify a file called GRCDiagnostic.rpd, and then use it to configure repositories. 

To do so, you must use a tool that runs only on a Windows-based computer. 

Throughout this section (as before), host is the FQDN of your GRC server, and port 

is the number you selected for the WebLogic Administration Server. (See step 7 of 

“Creating a WebLogic Domain” on page 2-5.)  

1. On a Windows machine, open an FTP client and connect to host.  

• Navigate to <OBIEE_TEMP>/repository.  

• Download the file GRCDiagnostic.rpd to you Windows machine. Then 

close the FTP client. 

2. On the Windows machine, go to http://www.oracle.com/technetwork/ 

middleware/bi-enterprise-edition/downloads/bus-intelligence-11g-165436.html. 

From that site, download and install Oracle Business Intelligence Developer 

Client Tools Installer (11.1.1.6.0). 

3. When the installation is complete, ODBC Data Source Administrator opens. 

Press Cancel to close it (it is not needed for this procedure.) 

4. Open the Oracle BI Administration Tool: From the Start menu, navigate to 

Oracle Business Intelligence Enterprise Edition Plus Client → Administration.  

5. Navigate to File → Open → Offline. Select the GRCDiagnostic.rpd file you 

downloaded in step 1. Enter Admin123 as the Repository Password. 

6. Navigate to Manage → Variables. 

• Double-click on GRI_DSN. Under Default Initializer, enter the service 

identifier (SID) for the Oracle database that hosts your DA schema, inside 

the single quotation marks. Press OK. 
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• Double-click on GRI_USER_ID. Under Default Initializer, enter the schema 

name used by your DA schema, inside the single quotation marks. Press OK. 

• Close the Variable Manager. 

7. In the main window under the Physical section, right-click on GRC Diagnostics 

and select Properties. 

• Click on the Connection Pools tab and double-click on GRCI Connection 

Pool. 

• Under the Shared Logon section, enter the schema password used by your 

DA schema. 

• Press OK, re-enter the schema password in the confirmation pop-up, and 

then press OK again. 

8. Navigate to File → Save and answer No to “Do you wish to check global 

consistency?” 

9. Exit the Oracle BI Administration Tool.  

Deploying GRCDiagnostic.rpd and Updating Scheduler Credentials 

If you installed GRC to run with Tomcat, start your Administration Server, BI 

Server, and BI components. Run the following commands: 

<OBIEE_MW>/user_projects/domains/bifoundation_domain/bin/start

WebLogic.sh 

<OBIEE_MW>/user_projects/domains/bifoundation_domain/bin/start

ManagedWebLogic.sh bi_server1 

<OBIEE_MW>/instances/instance1/bin/opmnctl startall 

If you installed GRC to run with WebLogic, the installation script has already 

started all necessary servers and components. 

No matter which web server you use, complete the following steps: 

1. Still on the Windows machine 

• If your GRC installation uses WebLogic, go to http://host:port/em. Log in 

to the host with your WebLogic Administration username and password. 

(See step 3 on page 2-4.) 

• If your GRC installation uses Tomcat, go to your Oracle Enterprise Manager 

URL. Log in with your WebLogic Administration username and password. 

(You noted the URL, user name, and password as you completed “Setting 

Up OBIEE in GRC in Tomcat,” page 3-8).  

2. From the left menu, expand Business Intelligence and double-click on 

coreapplication. 

3. Select the Deployment tab. 

4. Select the Scheduler tab. 
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5. Press Lock and Edit Configuration. 

6. Close the confirmation pop-up. 

7. Update the username to EGRCM_BIPLATFORM. 

8. Update the password and confirm password fields to grc. 

9. Click the Apply button. 

10. Click on the Activate Changes button on top. 

11. Click on Close after the changes are activated. 

12. Press Lock and Edit Configuration. 

13. Select the Repository tab. 

14. Under Upload BI Server Repository, click the Browse button and select the 

GRCDiagnostic.rpd that you modified and saved on your Windows machine in 

“Repository and WebCat Configuration” (page 3-9). Enter Admin123 in both of 

the Repository Password and Confirm Password fields. 

15. Under BI Presentation Catalog, enter the following as the Catalog Location: 

• If your GRC installation uses WebLogic: <MW_HOME>/instances/instance1/ 

bifoundation/OracleBIPresentationServicesComponent/coreapplication_obips1/ 

catalog/GRCDWebcat 

• If your GRC installation uses Tomcat: <OBIEE_MW>/instances/instance1/ 

bifoundation/OracleBIPresentationServicesComponent/coreapplication_obips1/ 

catalog/GRCDWebcat 

16. Click on the Apply button. 

17. Click on the Activate Changes button on top. 

18. Click on Close after the changes are activated. 

19. Press the Restart to apply recent changes button on top. 

20. Click on the Restart button. 

21. Select Yes. 

22. Click on Close after the restart completes. 

As long as the following BI components are up and running, warnings or errors 

related to any other components can be ignored. You can verify the status of these 

components by clicking on the Availability tab. If any of them are down, see the 

Troubleshooting section. 

• BI Presentation Services 

• BI Servers 

• BI Schedulers 

• BI Cluster Controllers 

• BI Java Hosts 
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Configuring Intelligence in GRC 

Within the GRC application, you need to enter values than enable GRC to connect 

to OBIEE, and you need to select “dashboards” in which GRC displays reports.  

1. Log on to GRC (see step 1 of “GRC Configuration” on page 2-18). Select Navi-

gator → Tools → Setup and Administration → Setup → Manage Application Con-

figurations → Analytics. 

2. In the GRC Intelligence Configuration section, supply the following values: 

• OBIEE Server Username: If your GRC installation uses WebLogic, the user 

name configured for the WebLogic Administration Server (see step 3 on page 

2-4). If your GRC installation uses Tomcat, the WebLogic Administration user-

name you noted in “Setting Up OBIEE in GRC with Tomcat” (page 3-8). 

• OBIE Server Password: The password for the OBIEE Server Username (see 

step 3 on page 2-4 if you use WebLogic, or “Setting Up OBIEE in GRC with 

Tomcat” on page 3-8 if you use Tomcat). 

• OBIEE Server Port: If you use WebLogic, 9704. If you use Tomcat, the 

port number noted under “Setting Up OBIEE in GRC with Tomcat ” on page 

3-8. 

• OBIEE Server Host: If you use WebLogic, the fully qualified domain name 

for the GRC host — the machine on which you installed GRC in Chapter 2. 

If you use Tomcat, the fully qualified domain name for the machine on 

which you installed OBIEE under “Setting Up OBIEE in GRC with Tomcat” 

on page 3-8. 

• Root Context: analytics 

Leave the Enable SSL Authentication check box unchecked. 

3. An Intelligence Page Configuration section displays a row for each dashboard 

you can display for GRC. (Each is identified as a “subtab” of an Intelligence tab 

that appears in, or in reference to, a major GRC page, such as the home page or 

an overview page for an object such as risk or continuous control.) 

• To enable a dashboard, double-click in its field in the Enable column until a 

check mark appears. To disable it, double-click until the check mark disap-

pears. 

• To modify the display name of a dashboard, double-click in its field in the 

Display Label column. The field becomes write-enabled; enter the name 

you want to use. 

4. A GRCI Intelligence Standard Mode Link Configuration section contains a 

single field, GRCI Intelligence Standard Mode URL. If you have installed a 

standalone instance of OBIEE, enter the URL for that instance.  

5. When you finish entering values, click on Action → Save. If you’ve modified 

settings in the GRC Intelligence Configuration section, GRC tests the values 

you’ve entered and, if they are valid, saves them. (If any are invalid, an error 

message instructs you to re-enter them.) 

6. Look for the prompt, “Successfully saved configuration values.” 
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In addition, each GRC user who is to have access to GRCI must be granted one or 

more of three GRC job roles: GRC Intelligence Administrator Job Role, GRCM 

Embedded Intelligence Viewer Job Role, and CCM Embedded Intelligence Viewer 

Job Role. For information on adding job roles to GRC user accounts, see the Enter-

prise Governance, Risk and Compliance User Guide.  

Testing the Installation 

As a first test, ensure that you can open OBIEE: 

• If your GRC installation uses WebLogic, open a browser and go to 

http://host:9704/analytics (in which host is the FQDN of your GRC server). Log 

in with your WebLogic Administration username and password. (See step 3 on 

page 2-4.)  

• If your GRC installation that uses Tomcat, open a browser and go to your Busi-

ness Intelligence Enterprise Edition URL. Log in with your WebLogic Admin-

istration username and password. (You noted the URL, user name, and password 

as you completed “Setting Up OBIEE in GRC with Tomcat,” page 3-8). 

Second, ensure that the GRCI dashboard loads with no errors in your GRC 

application: 

1. Ensure that the DA schema has been refreshed (see page 3-2).  

2. Log on to GRC (see step 1 of “GRC Configuration” on page 2-18). Use the 

logon credentials of a user who has been assigned GRCI job roles.  

3. Click on the Intelligence tab for each of the home and overview pages in which 

you’ve enabled a GRCI dashboard. (See step 3 of “Configuring Intelligence in 

GRC,” page 3-12.) 

If you see no errors, the integration has been successful.  

Troubleshooting 

As you install GRCI, you may encounter the following problems: 

• An invalid property value is entered, and the installation script has run through 

the string replacement stage. 

You must start over. However, before running the installation script, you must 

either remove the obiee.properties and installation.stages files from your 

<MW_HOME> directory, or find the invalid value in obiee.properties and fix it 

after deleting the installation.stages file. 

• An invalid property value is entered, and the installation script has not run 

through the string replacement stage. 

Simply remove the obiee.properties and installation.stages files from your 

<MW_HOME> directory and start the script over to go through the properties 

questionnaire. 
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• The installer skips through a stage that needs to be redone. 

Edit the installation.stages file and remove the line that has the flag corre-

sponding to the stage you are trying to redo. 

• After BI components are restarted, one or more of them are not running. 

Depending on which component fails to start, look un <MW_HOME>/instances/ 

instance1/diagnostics/logs/<OracleBIComponentName>coreapplication_obis1 

and examine the log files that were modified most recently. They will contain 

information you can use to resolve the startup issue. 

• You see SQL errors in GRCI sashboards, or any of your OBIEE components 

fail to start. 

Check the following logs for more information on the errors. In the following 

paths, replace <OBIEE_HOME> with the value for <OBIEE_MW> if your GRC 

installation uses Tomcat, or with the value for <MW_HOME> if your GRC instal-

lation uses WebLogic. 

– Presentation Services Log: 

<OBIEE_HOME>\instances\instance1\diagnostics\logs\OracleBIPresentation

ServicesComponent\coreapplication_obips1\sawlogo.log 

– BI Server Component: 

<OBIEE_HOME>\instances\instance1\diagnostics\logs\OracleBIServerComp

onent\coreapplication_obis1\nqquery.log  

<OBIEE_HOME>\instances\instance1\diagnostics\logs\OracleBIServerComp

onent\coreapplication_obis1\nqserver.log  

– BI Scheduler Component: 

<OBIEE_HOME>\instances\instance1\diagnostics\logs\OracleBISchedulerCo

mponent\coreapplication_obisch1\nqscheduler.log 

– BI Cluster Component: 

<OBIEE_HOME>\instances\instance1\diagnostics\logs\OracleBIClusterContr

ollerComponent\coreapplication_obiccs1\nqcluster.log  

– Java host Component: 

<OBIEE_HOME>\instances\instance1\diagnostics\logs\OracleBIJavaHostCo

mponent\coreapplication_obijh1\jh.log 

• Other problems. 

Check <MW_HOME>/installation.log or <MW_HOME>/instances/instance1/ 

diagnostics/logs/<OracleBIComponentName>coreapplication_obis1. Look for an 

error message to help you gather more information on the problem and possibly 

lead you to its resolution. 
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Deploying a VM Image of GRC 

Rather than perform a conventional GRC installation, you can deploy a GRC image 

configured in advance by Oracle. You would use Oracle VM Server to deploy the 

image.  

The image is an instance of GRC running with WebLogic. The image is initially 

configured to run without SOA; however, a SOA instance is included, and once 

deployment is complete you can configure the image to use SOA worklists. All other 

required elements, such as operating system and database, are included in the image. 

The database includes both a GRC schema (which serves the application itself) and 

a data analytics schema (for use in enhanced reporting). 

Deploying a GRC Distribution 

To deploy an Oracle GRC distribution for Oracle VM Server: 

1. Obtain and install Oracle VM Manager and Oracle VM Server 3.1.1. 

2. Add the hostname of the machine hosting Oracle VM Server to the “server 

pool” in Oracle VM Manager. 

3. Extract an Oracle GRC Distribution into the “running_pool” directory on the 

Oracle VM Server. Use grcm.tar.gz if you want to run Enterprise Governance, 

Risk and Compliance Manager, or grcc.tar.gz if you want to run Advanced Con-

trols. Within an instance of Oracle VM Server, you must choose one or the other; 

you can’t choose both. 

4. Open the file vm.cfg in a text editor. (It’s located in the directory extracted from 

the Oracle GRC Distribution.) In it, locate the “disk” line. Edit this line to contain 

the path to system.img (which resides in the same directory as vm.cfg, extracted 

from the Oracle GRC Distribution).  

5. Log in to Oracle VM Manager. On the Resources tab, select Virtual Machine 

Images. 

6. Click on the Import button. 

7. Select the second option, “Select from Server Pool (Discover and register).” 

Then click Next. 
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8. Ensure your VM is selected in a Virtual Machine Image Name drop-down field. 

(Your VM is stored in a subdirectory of the “running_pool” directory, and its 

name is the same as the name of this subdirectory.) Then select and fill in other 

fields. (For operating system, select Oracle Enterprise Linux 5 64-bit.) Click the 

Next button. 

9. A confirmation page appears. Review it and (assuming values are correct) click 

on the Confirm button. The Virtual Machine Images entry page reappears. 

10. Click on the Approve button. Another confirmation page appears. Review it and 

(assuming values are correct) click on the Confirm button. 

11. You should now see the VM in a powered off state. Click the Power On button 

and enter “OS in Single User Mode.” 

12. Once in Single User Mode, change the “root” user password and edit the net-

work configurations to make the VM accessible on your network.  

Change the hostname and IP of the VM in the following files: 

/etc/hosts/ 

/etc/resolv.conf 

/etc/sysconfig/network 

/etc/sysconfig/network-scripts/ifcfg-eth0 

Change the hostname and IP of the DB in the following files: 

/u01/app/oracle/product/11.2.0/db/network/admin/listener.ora 

/u01/app/oracle/product/11.2.0/db/network/admin/tnsnames.ora 

When all updates are completed, restart the instance. 

13. Once the startup is completed, you should be able to log into the instance as the 

“root” user or the “oracle” user. All applications are owned by the oracle user.  

Users and Passwords 

Default usernames and passwords within a GRC image include the following: 

• Oracle Database: sys/manager 

• Oracle Database: system/manager 

• OS (root user): root/welcome 

• OS (oracle user): oracle/welcome 

• WebLogic Administration Server: weblogic/welcome1 

• SOA (soa_server1) Managed Server: weblogic/welcome1 

• Oracle WebLogic Server Console: weblogic/welcome1 

• Oracle WebLogic Server Enterprise Manager: weblogic/welcome1 

• GRC Schema: grc_user/grc_password 

• GRC Data Analytics Schema: grc_user_da/grc_password 
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Log File Locations 

Default locations of log files within a GRC image include the following: 

• Oracle Weblogic Server - AdminServer (nohup): 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/bin/wls.log 

• Oracle Weblogic Server - SOA (soa_server1) Managed Server (nohup): 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/bin/soa.log 

• Oracle Weblogic Server - AdminServer: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/servers/Admin

Server/logs 

• Oracle Weblogic Server - SOA (soa_server1) Managed Server: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/servers/soa_ 

server1/logs 

• GRC Log: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/servers/Admin

Server/stage/grc864/grc864/grc/log/grc.log 

Starting a GRC Distribution 

To start an Oracle GRC distribution for Oracle VM Server: 

1. Log into the instance as the oracle user. 

2. Set the ORACLE_HOME environment variable: 

export ORACLE_HOME=/u01/app/oracle/product/11.2.0/db 

3. Set the ORACLE_SID environment variable: 

export ORACLE_SID=orcl 

4. Add ORACLE_HOME/bin to the PATH: 

export PATH=$ORACLE_HOME/bin:$PATH 

5. Use SqlPlus to start the Oracle database. For example: 

sqlplus /nolog 

SQL> connect / as sysdba 

SQL> startup 

SQL> exit 

6. Start the Oracle Database Listener: 

lsnrctl start 

7. Set your path to the following: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/ 

bin 

8. Start the WebLogic Administration Server: 

nohup ./startWeblogic.sh > wls.log & 
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9. Optionally, start the WebLogic SOA Managed Server (soa_server1). This step 

applies to EGRCM only. 

nohup ./startManagedWeblogic.sh soa_server1 > soa.log & 

10. Verify that WebLogic and (if applicable) SOA are available by connecting to 

the Oracle WebLogic Server Enterprise Manager. (Replace <hostname> with 

the value you created in step 12 of “Deploying a GRC Distribution,” page 4-2.) 

http://<hostname>:7001/em 

11. Verify that the GRC application (grc864) is available by connecting to the 

Oracle WebLogic Server Console. (Replace <hostname> with the value you 

created in step 12 of “Deploying a GRC Distribution,” page 4-2.) 

http://<hostname>:7001/console 

12. Logon to the GRC application. (Replace <hostname> with the value you created 

in step 12 of “Deploying a GRC Distribution,” page 4-2.) 

http://<hostname>:7001/grc 

Stopping a GRC Distribution 

To stop an Oracle GRC distribution for Oracle VM Server: 

1. Log into the instance as the oracle user. 

2. Set the ORACLE_HOME environment variable: 

export ORACLE_HOME=/u01/app/oracle/product/11.2.0/db 

3. Set the ORACLE_SID environment variable: 

export ORACLE_SID=orcl 

4. Add ORACLE_HOME/bin to the PATH: 

export PATH=$ORACLE_HOME/bin:$PATH 

5. Set your path to the following: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/ 

bin 

6. If the WebLogic SOA Managed Server (soa_server1) is running, stop it. This 

step applies to EGRCM only. 

./stopManagedWeblogic.sh soa_server1 

7. Stop the WebLogic Administration Server: 

./stopWeblogic.sh 

8. Stop the Oracle Database Listener 

lsnrctl stop 

9. Use SqlPlus to start the Oracle database. For example: 

sqlplus /nolog 

SQL> connect / as sysdba 

SQL> shutdown immediate 

SQL> exit 
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Additional Advanced Controls Configuration 

Once you’ve installed GRC, complete additional configuration procedures as 

needed if you intend to use AACG or ETCG (which run as a Continuous Controls 

Monitoring module in GRC):  

• Define the information AACG uses to create “global users.” Within business 

applications subject to AACG models and controls, individual users may have 

user-account information that varies from one application to the next. For each 

such person, GRC creates a “global user” and maps that person’s business-

application IDs to it. You must change the default global-user value if you are 

implementing FAACG (installing GRC to apply AACG models and controls 

within Oracle Fusion Applications). Otherwise, global-user configuration is 

optional. 

• Set up datasources — connections to applications in which GRC is to perform 

analysis. In addition, synchronize data for each datasource — collect informa-

tion required for AACG or ETCG analysis, and provide that information a format 

that GRC recognizes. (For an AACG instance or an ETCG instance that performs 

analysis in Oracle EBS of PeopleSoft, both datasource configuration and data 

synchronization are somewhat different than for FAACG instances.) 

Configuring Global Users 

Implement one of the following options to determine the information GRC uses to 

create global users. Important: Select an option that identifies each person uniquely. 

• EMAIL_ONLY: Match the global user to email addresses from distinct data-

sources (or within one datasource). This is the default. 

• EMAIL_AND_USERNAME: Match the global user to email address plus username 

from distinct datasources (or within one datasource). You must select this option 

if you are implementing FAACG. 

• EMAIL_AND_ALL_NAMES: Match the global user to email address, username, 

given name, and surname from distinct datasources (or within one datasource). 

As regular procedures, GRC users “synchronize data” (collect information required 

for AACG or ETCG analysis, and provide that information to GRC) and analyze con-

trols to produce “incidents” (records of control violations).  
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Changing a global-user configuration is simplest if no one has yet synchronized data 

or analyzed controls on your GRC instance. Complete the following three steps: 

1. Use SQL*Plus, or any other tool with the ability to execute SQL commands on 

a database, to connect to the GRC schema.  

2. Run the following SQL statement: 

DELETE FROM GRC_PROPERTIES 

WHERE NAME like 'GLOBAL_USER_CONFIG'; 

COMMIT; 

3. Run one of the following SQL statements, depending on the global-user format 

you want to implement: 

For email and username, run the following statement: 

Insert into GRC_PROPERTIES (NAME, VALUE, DESCRIPTION, DEFAULT_VALUE, 

VISIBLE, CONFIGURABLE, DATA_TYPE_ID)Values ('GLOBAL_USER_CONFIG', 

'EMAIL_AND_USERNAME', 'Global User configuration. Possible values: 

EMAIL_ONLY, EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 

0, 0, 0); 

COMMIT; 

For email, username, given name, and surname, run the following statement: 

Insert into GRC_PROPERTIES (NAME, VALUE, DESCRIPTION, DEFAULT_VALUE, 

VISIBLE, CONFIGURABLE, DATA_TYPE_ID) Values ('GLOBAL_USER_CONFIG', 

'EMAIL_AND_ALL_NAMES', 'Global User configuration. Possible values: 

EMAIL_ONLY, EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 

0, 0, 0);  

COMMIT; 

For email only, run the following statement. (As already noted, email-only is the 

default configuration. Run this statement only if you have changed your global-

user configuration to one of the other formats, and want to change back.) 

Insert into GRC_PROPERTIES (NAME, VALUE, DESCRIPTION, DEFAULT_VALUE, 

VISIBLE, CONFIGURABLE, DATA_TYPE_ID) Values ('GLOBAL_USER_CONFIG', 

'EMAIL_ONLY', 'Global User configuration. Possible values: EMAIL_ONLY, 

EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 0, 0, 0); 

COMMIT; 

A second possibility is that data has been synchronized, but controls have not been 

analyzed, on your GRC instance. In this case, when you change your global-user con-

figuration, all existing global-user data will be wiped out.  

1. Complete the steps outlined above for the first global-user-configuration sce-

nario (in which data synchronization and control analysis have not occurred). 

2. Sill logged on to your SQL tool, also run the following SQL statement: 

TRUNCATE TABLE LAA_USER_MAPPING; 

TRUNCATE TABLE LAA_GLOBAL USER; 

COMMIT; 
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A third possibility is that data has been synchronized, controls have been analyzed, 

and incidents have been generated on your GRC instance. In this case, when you 

change your global-user configuration, all existing incidents become invalid, and all 

existing global-user data will be wiped out.  

1. Log on to GRC (see page 2-18). Select Setup and Administration under Tools in 

the Navigator, then Manage Application Configurations under Setup. Select the 

Maintenance tab, and from the Maintenance page, purge all existing incidents. 

(For detailed instructions on purging incidents, see the Enterprise Governance, 

Risk and Compliance User Guide.) 

2. Still logged on to GRC, go to the Manage Results page. (Select Manage Inci-

dent Results from the Result Management tasks available under Continuous 

Control Management in the Navigator.) Select Incident Result in the View By 

list box, and confirm that no incidents exist.  

3. Log off of GRC and shut down the application server.  

4. Complete the steps outlined above for the first global-user-configuration sce-

nario (in which data synchronization and control analysis have not occurred). 

5. While logged on to your SQL tool, also run the following SQL statement: 

TRUNCATE TABLE GRC_SUM_CTRL_INC; 

TRUNCATE TABLE LAA_USER_MAPPING; 

TRUNCATE TABLE GRC_GLOBAL_USER; 

DROP VIEW GRC_INC_CTRL_V; 

DROP VIEW GRC_INC_CTRL_H_V; 

COMMIT; 

6. Clear the contents of your Transaction ETL Path folder (see step 2 on page 2-18). 

Configuring Datasources and Synchronizing Data 

Connect GRC to datasources (instances of business-management applications that 

are to be subject to its analysis). Also synchronize data for each datasource — 

collect information required for AACG or ETCG analysis. 

Synchronization and Global Users 

GRC creates one global user for each user in the first datasource for which you 

synchronize access data. It adopts the ID configured for each user in that datasource 

as that user’s global ID. When you synchronize data for a second datasource, GRC 

matches users who also exist in the first datasource to their already-existing global 

user IDs. For each “new” user — each of those who do not exist in the first datasource 

— GRC adopts the user ID from the second datasource as the user’s global ID. And 

so on for each datasource for which you synchronize data. 

AACG pages display the global user ID for each business-application user. A given 

user’s ID may differ from one datasource to the next, and you may prefer to set IDs 

from a particular datasource as the global user IDs. 

It’s recommended, therefore, that you configure all datasources in which you expect 

to apply AACG models and controls before you synchronize data for any of them. 

Next, choose the datasource from which you want GRC to adopt IDs as global user 

IDs, and synchronize that datasource first. Establish an order for the remaining data-
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sources, each of which sets global IDs for users who do not exist in the datasources 

for which synchronization has already been completed. Then synchronize the remain-

ing datasources in that order. 

A Special Case Involving Tomcat and SQL Server 

If your GRC instance runs with Tomcat Application Server, and if you connect to a 

Microsoft SQL Server datasource, you need to install a JDBC driver before you syn-

chronize data for that datasource: On the GRC server: 

1. Download the UNIX version of the JDBC driver — sqljdbc_*.tar.gz — from 

http://msdn.microsoft.com/en-us/data/aa937724.aspx. 

2. From the download file, extract the JDBC driver for SQL Server 2005 and 

newer — sqljdbc4.jar. (A SQL Server 2000 driver is also included in the down-

load file, but is not supported by GRC.) 

3. Copy the sqljdbc4.jar file to <TomcatHome>/webapps/grc/WEB-INF/lib. 

4. Restart Tomcat. 

How to Configure Datasources 

To configure datasources or to synchronize their data, log on to GRC (see page 2-

18). Select Setup and Administration under Tools in the Navigator, then Manage 

Application Datasources under Setup. 

To configure an Oracle EBS or PeopleSoft datasource, complete these steps. (The 

procedure is somewhat different for a Fusion datasource; see page 6-5.) 

1. Click on Actions → Create New. A Create Datasource window opens. Enter the 

following values: 

• Datasource Name: Create a name for the datasource. 

• Description: Type a brief description of the datasource (optional). 

• Application Type: Select the type of business application to which you are 

connecting, such as EBS or PeopleSoft. 

• Application Type Version: Select the version number of the business-

management application to which you are connecting. 

• Default Datasource: Select the checkbox to make the datasource you are 

configuring the default for use in transaction models. Only one datasource 

can have this value selected. 

• Connector Type: For an Oracle EBS or PeopleSoft datasource, select 

Default. For any other application, you would need to have created and 

uploaded a custom connector; select it. 

• Connector Properties: Enter values required for the connector you specified 

in Connector Type. Values vary by connector. They may include: 

– ERP Database Type: Select the type of database — Oracle, MS SQL 

Server, or DB2 — used by the business-management application being 

configured as a datasource. 
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– Hostname: For Oracle EBS or PeopleSoft, supply the fully qualified 

domain name (FQDN) for the machine that hosts the database used by 

the business-management application. Or, if the datasource is RAC-

enabled, enter RAC@<SCAN_NAME>, where <SCAN_NAME> is the 

IP address/host name configured for the RAC database. 

– Password: For Oracle EBS or PeopleSoft, enter the password for the 

business-application database.  

– Port: For Oracle EBS or PeopleSoft, enter the port number that the 

business-application database uses to communicate with other 

applications.  

– Service Name: For Oracle EBS or PeopleSoft, supply the SID value 

configured for the business-application database in the tnsnames.ora 

file. Or, if the datasource is RAC-enabled, enter the RAC service name 

configured for the RAC database. 

– Username: For Oracle EBS or PeopleSoft, supply the user name for the 

business-application database. (For an Oracle database, this is the same 

as Schema Name; for an Oracle EBS instance, this is typically APPS.)  

2. After entering values, click on the Test Connection button.  

3. When the test completes successfully, click the Save or Save and Close button. 

A row representing the datasource appears in the Manage Application Data-

sources grid. 

How to Synchronize Data 

To perform data synchronization: 

1. In the Manage Application Datasources page, select the row for the datasource 

with which you want to synchronize data.  

2. Do either of the following: 

• Click on Actions → Synchronize Access. This causes data used by AACG 

to be synchronized once, immediately. 

If you are upgrading from an earlier version, you must run access synchroni-

zation for each datasource. (You must first have deleted the content of a 

directory that stores ETL data used by ETCG. This should have occurred 

when you completed “Creating GRC Repositories” on page 2-3.) 

• Click on Actions → Synchronize Transaction. This causes data used by 

ETCG to be synchronized once, immediately. 

(You may also select another option, Actions → Schedule Synchronize, to estab-

lish a schedule on which data synchronization occurs regularly. For more on this, 

see the Enterprise Governance, Risk and Compliance User Guide.) 

Each time a datasource is synchronized, GRC updates fields in the row for that 

datasource: Last Access Synchronization Date and Last Access Synchronization 

Status show the date of the most recent access synchronization, and its completion 

status. Last Transaction Synchronization Date and Last Transaction Synchronization 

Status do the same for the most recent transaction synchronization. 



 

5-6 Oracle Enterprise Governance, Risk and Compliance Installation Guide 

Determining Datasource IDs 

When you configure a datasource, GRC assigns an ID number to it. If you intend to 

implement preventive analysis for an Oracle EBS or PeopleSoft datasource, you 

need to know its datasource ID. To determine the number, configure the datasource, 

then complete the following steps: 

1. In the Manage Application Datasources page, right-click on the header row in 

the grid that displays configured datasources. 

2. A list of available columns appears. In it, select the check box for the Datasource 

ID column (click on it so that a check mark appears). 

3. Left-click anywhere outside of the list of columns to close it. 

4. The Manage Application Datasources page now displays a Datasource ID 

column. In it, note the ID number assigned to the datasource you’ve configured. 

If, having determined the datasource IDs for your datasources, you wish to remove 

the Datasource ID column from view, repeat this procedure but clear the Datasource 

ID check box (click on it so that the check mark disappears). 
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Setting Up FAACG 

If you have installed Enterprise Governance, Risk and Compliance so that you can 

use Application Access Controls Governor to perform segregation-of-duties analysis 

in Oracle Fusion, complete the procedures in this chapter. (If not, then this chapter 

does not apply to you.)  

As prerequisites, Fusion Human Capital Management (HCM) and Oracle Identity 

Management (OIM) must be installed, through the Fusion Applications provisioning 

process. In conjunction with this, Oracle Internet Directory (OID) must be set up as 

the LDAP repository whose identity store is managed by OIM. In addition, you 

must have installed GRC to run with WebLogic (see “Prerequisites” on page 1-2, as 

well as chapter 2 of this document).  

To set up Fusion Application Access Controls Governor (FAACG), change the 

GRC “global user” configuration to EMAIL_AND_USERNAME (see page 5-1). Then 

install a “connector” within your GRC instance. (The connector collects data from a 

Fusion instance and provides it in a format that GRC recognizes.) Finally , use Fusion 

Setup Manager to perform GRC setup.  

Installing the Connector 

To install a connector, you use a Manage Application Libraries page available in 

GRC. Before doing so, however, you must complete several preliminary configu-

ration steps. 

Associate the GRC Domain with OID 

To begin, associate your GRC domain (set up in “Creating a WebLogic Domain” on 

page 2-4) with a “security store” maintained by OID.  

1. Invoke the WebLogic scripting tool — wlst.sh — from <MW_HOME>/oracle_ 

common/common/bin. 

2. Enter the following command: 

reassociateSecurityStore(domain="fusion_domain", 

servertype="OID", ldapurl="host:port", jpsroot="cn=nodename", 

admin="cn=adminuser", password="adminpassword", join="true") 
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In this command: 

• fusion_domain is the name of the Fusion policy store (which is, in turn, the 

branch of the security store that identifies privileges that can be granted within 

applications). This value is identified beneath the “cn=JPSContext” entry in 

the OID LDAP tree. 

• host is the FQDN of the LDAP provider (your OID instance), and port is 

the port number at which it communicates with other applications. 

• nodename is the root node for your policy store within the OID LDAP tree. 

• adminuser is the username for the OID administrative user. 

• adminpassword is the password configured for the OID administrative user.  

3. Bounce the WebLogic Administration Server and managed servers. 

Create an OIDAuthenticator 

Next, create an OIDAuthenticator. (However, skip this section if you installed GRC 

so that an external OID LDAP repository manages its users — if you completed the 

“Configuring External OID LDAP” section beginning on page 2-6.)  

1. Log in to the WebLogic Server Administration Console: 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-5.) 

2. Click on the “Security Realms” link in your application’s Security Settings. 

3. Click on the “myrealm” link in the table. 

4. Click on the “Providers” tab. 

5. Click on the New button and enter the following values: 

• Name: OIDAuthenticator 

• Type: OracleInternetDirectoryAuthenticator 

6. Click on the “OIDAuthenticator” link and then click on the “Provider Specific” 

tab. 

7. Supply values for properties in the “Provider Specific” screen. (Italicized entries 

are literal values, to be entered as they are shown.) 

• Host: The FQDN of the LDAP provider (your OID instance). 

• Port: The port number at which the host communicates with other applica-

tions. 

• Principal: The username for the OID administrative user, preceded by cn=. 

• Credential: The password configured for the OID administrative user. 

• Confirm Credential: The password configured for the OID administrative 

user. 

• SSLEnabled: Leave this box unchecked. 
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• User Base DN: The LDAP path to the store for user information. For 
example: cn=FusionUsers,cn=users,dc=us,dc=oracle,dc=com 

• All Users Filter: (&(uid=*)(objectclass=person)) 

• User From Name Filter: (&(uid=%u)(objectclass=person)) 

• User Search Scope: subtree 

• User Name Attribute: uid 

• User Object Class: person 

• Use Retrieved User Name as Principal: Select this checkbox. 

• Group Base DN: The LDAP path to the store for group (enterprise role) 

information. For example: cn=FusionGroups,cn=groups,dc=us,dc=oracle, 

dc=com 

• All Groups Filter: (&(cn=*)(|(objectclass=groupofUniqueNames) 

(objectclass=orcldynamicgroup))) 

• Group From Name Filter: (|(&(cn=%g)(objectclass=groupofUniqueNames)) 
(&(cn=%g)(objectclass=orcldynamicgroup))) 

• Group Search Scope: subtree 

• Group Membership Searching: unlimited 

• Static Group Name Attribute: cn 

• Static Group Object Class: groupofuniquenames 

• Static Member DN Attribute: uniquemember 

• Static Group DN from Member DN filter: (&(uniquemember=%M)(objectclass= 
groupofuniquenames)) 

• Dynamic Group Name Attribute: cn 

• Dynamic Group Object Class: orcldynamicgroup 

• Dynamic Member URL Attribute: labeleduri 

• User Dynamic Group DN Attribute: Leave this field blank. 

• Connection Pool Size: 6 

• Connect Timeout: 0 

• Connection Retry Limit: 1 

• Parallel Connect Delay: 0 

• Results Time Limit: 0 

• Keep Alive Enabled: Leave this box unchecked. 

• Follow Referrals: Select this checkbox. 

• Bind Anonymously On Referrals: Leave this box unchecked. 

• Propagate Cause For Login Exception: Leave this box unchecked. 

• Cache Enabled: Select this checkbox. 

• Cache Size: 32 

• Cache TTL: 60 

• GUID Attribute: orclguid 
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8. Save your settings, then click on “Activate Changes” on the left, topmost panel. 

9. Click the “OIDAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

10. Click the “DefaultAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

11. Click the Reorder button. Select “OIDAuthenticator” from the available provid-

ers, and move it to the top. To do so, click on the arrow on the right side, then 

click OK. 

12. Click on “Activate Changes” from the Change Center, then log out. 

13. Bounce the WebLogic Administration Server and managed servers. 

Grant Permission to the GRC Code Base 

Use the WebLogic scripting tool to grant necessary permissions. 

1. Invoke the WebLogic scripting tool — wlst.sh — from <MW_HOME>/oracle_ 

common/common/bin. 

2. Execute the grantPermission command twice, as shown below. In the commands, 

replace <grc864> with the full path to the grc864 directory created in step 3 of 

“Preparing Additional Files,” on page 2-7. All other arguments to the commands 

are literal values, to be entered as shown. 

grantPermission(codeBaseURL= "file:/<grc864>/WEB-INF/-", 

permClass="oracle.security.jps.service.policystore.PolicySt

oreAccessPermission", permTarget="context=SYSTEM",  

permActions="getConfiguredApplications") 

grantPermission(codeBaseURL= "file:/<grc864>/WEB-INF/-, 

permClass="oracle.security.jps.service.policystore.PolicySt

oreAccessPermission", permTarget="context=APPLICATION, 

name=*", permActions="getApplicationPolicy") 

3. Bounce the WebLogic Administration Server and managed servers. 

Upload the Connector 

The Fusion connector is provided in a file called grc-connector-fusion-8.6.4.3-

SNAPSHOT-connectorsetup.zip. To upload it to GRC: 

1. Log on to GRC. In a web browser, enter the following URL, in which host is 

the FQDN of your GRC server, and port is the number you chose for the GRC 

managed server as you created a WebLogic domain. (See step 8 of “Creating a 

WebLogic Domain” on page 2-5.) 

http://host:port/grc 

2. In the Navigator, select Setup and Administration → Setup → Manage 

Application Libraries. Click the Connectors tab. 

3. Click on Actions → Import. 

4. A Import File pop-up window opens. Click on its Browse button. 
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5. A file-upload dialog opens. In it, navigate to, and select, grc-connector-fusion-

8.6.4.3-SNAPSHOT-connectorsetup.zip, which is among the files in <grc_stage> 

directory (see “Downloading Files” on page 2-3 ). The path and name of the file 

then populate the field next to the Browse button in the Import File window.  

6. Click on the Upload File button. A pop-up message reports the status of the 

upload operation. Click on its OK button to clear it, and then click on the Close 

button in the Import File window. 

7. Log off of GRC and restart both the Administration Server and the GRC 

managed server. (Before doing so, be sure that the file tika-app-0.9.jar does not 

exist in the library subdirectory of your web application server). 

Create and Synchronize a Datasource 

Having uploaded the connector, you will need to configure a datasource that asso-

ciates your Fusion instance with the connector: 

1. Log on to GRC once again. 

2. Navigator → Setup and Administration → Setup → Manage Application 

Datasources. 

3. Click on Actions → Create New. A Create Datasource window opens. Enter the 

following values: 

• Datasource Name: Create a name for the datasource. 

• Description: Type a brief description of the datasource (optional). 

• Application Type: Select the type of business application to which you are 

connecting — in this case, Fusion. 

• Application Type Version: Select the version number of the Fusion instance 

to which you are connecting. 

• Default Datasource: Clear this check box. 

• Connector Type: For Fusion, select the Fusion connector you installed prior 

to working in this Manage Application Datasources page; the correct value 

is FusionConnector. 

4. Click the Save or Save and Close button. A row representing the datasource 

appears in the Manage Application Datasources grid. 

Finally, perform a data synchronization. In the Manage Application Datasources 

page, select the row you’ve just created for the Fusion datasource. Then either click 

on Actions → Synchronize Access, or click on the Synchronize button in the tool 

bar, then on a Run Now option, and then on an Access option. 

Performing GRC Setup in Fusion Setup Manager 

Once the Fusion connector is installed, create an implementation project for GRC in 

Fusion Setup Manager (FSM).  

It’s assumed you are familiar with use of the Fusion Setup Manager, and with terms 

such as offerings, activities, tasks, and tasklists. If not, see the Oracle Fusion Appli-

cation Installation Guide and the Fusion Setup Manager Administrator's Guide.  
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Portlet Registration 

Begin by ensuring that GRC is registered successfully in FSM. With FSM open, 

select Manage Portlet Registration under Implementations in the Tasks list (along 

the left of the interface). If the Manage Portlet Registration page does not show that 

GRC is registered, search for the “GRC Setup” Enterprise-Application and perform 

the portlet registration. Refer to the FSM Administrator’s Guide for instruction on 

how to perform portlet registration.  

Configure Offerings 

Because seeded offerings are not GRC-enabled by default, use a Configure 

Offerings page to enable GRC for the desired offering.  

1. Open the page: Select Configure Offerings under Implementations in the Tasks 

list. 

2. Click on the Select Feature Choices icon for the selected offering. For example, 

selecting the icon for the Customer Data Management offering displays a screen 

in which Enterprise Governance, Risk and Compliance is listed. 

3. Select the Enterprise Governance, Risk and Compliance entry — click on it so 

that a check mark appears in its check box.  

4. Click Save and Close.  

Implementation Project 

To display a GRC-Setup screen within FSM, create one or more implementation 

projects. You can base a project on the offerings enabled for GRC, or you can 

directly add GRC-Setup tasks (and tasklists). In either case, expanding a node will 

display a “Go to Task” icon for the selected task within the node, and clicking on it 

will render the GRC-Setup screen. 

Create a GRC Setup Master Record 

When you select a Go-to-Task icon, a Manage Setup Configurations screen enables 

you to create new GRC setup records or to search for, update, or delete existing records. 

Click the Create New icon to open a Configuration screen, in which you can create 

or register a new GRC Setup configuration master record.  

In this page, supply the following values: 

• Code: A code that uniquely identifies the master record being created, for 

example GRC_HCM. 

• Name: Short name to describe the code, for example “GRC Setup Data for 

Human Capital Management.” 

• Description: Full description, for example, “This is the master record to define 

GRC Setup data to enforce separation of duties mandate for HCM.” 

Click the Save and Continue button to save the date prior to creating detail records. 

(Clicking on Save and Close returns you to the Manage Setup Configurations 

screen.) 
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Create a GRC Setup Detail Record 

In the Configuration (master-record) screen, locate the Configuration Details panel 

and click on its Create New icon. A Configuration Details screen opens, in which 

you can create detail records for the master record. 

In this page, enter the following values: 

• Detail Name: Code that uniquely identifies the detail record being created. 

• Name: Short name to describe the code. 

• Description: Full description. 

• Status: Nonmandatory field to specify the status of the detail record. It typically 

contains Active or Inactive. 

• Services URL: http://host:port/grc/Services/GrcService, in which host is the 

FQDN of your GRC server, and port is the number you chose for the Admin-

istration Server as you created a WebLogic domain. (See step 7 of “Creating a 

WebLogic Domain” on page 2-5.) 

• User Name: The user name for a user granted the Admin role defined in the 

GRC UI. 

• Password: The password for the user granted the Admin role. 

• Confirm Password: The same password, entered for verification. 

• GRC Data Source: The name of the datasource configured under “Create and 

Synchronize a Datasource” on page 6-5. 

Click on Save and Close to return to the Configuration screen.  

Publish Configuration 

When detail records are complete, they must be published to Oracle Identity 

Management. From the Configuration (master-record) screen, select (click on) a 

detail record in the Configuration Details panel. Then select the Publish to OIM 

icon (it looks like an arrow pointing upwards).  

A Publish Configuration to OIM pop-up window opens. In it, enter these values: 

• Protocol: The protocol used for communication with the OIM managed server. 

Either https or t3s is recommended, but you may use any protocol the OIM 

managed server accepts. 

• OIM Hostname: The name of the host of the OIM managed server. 

• Port Number: The port of the OIM managed server. 

• OIM User Name: The name of the user with admin role on the OIM managed 

server. (This user must be able to invoke MBean operations.) 

• OIM Password: The password of the OIM user. 

 

  



 

6-8 Oracle Enterprise Governance, Risk and Compliance Installation Guide 

 

 



 

 Installing PEAs 7-1 

7 

Installing PEAs 

In support of the AACG preventive analysis feature, install a Preventive Enforce-

ment Agent (PEA) on each instance of Oracle E-Business Suite or PeopleSoft that is to 

be subject to AACG analysis. 

There are distinct PEAs (and installation procedures) for EBS and PeopleSoft. See 

the Oracle Enterprise Governance, Risk and Compliance Certifications Document 

for supported versions of Oracle EBS and PeopleSoft. Even if you have installed a 

PEA for an earlier version of GRC, you must reinstall it for version 8.6.4.5000. 

PEAs and SSL 

You can install a PEA (on Oracle EBS or PeopleSoft) so that it supports Secure 

Sockets Layer (SSL). To do so, you must first set up GRC itself to support SSL (see 

“GRC and SSL” on page 2-22). Then, in the OEBS or PeopleSoft instance on which 

you are installing a PEA, run the following command: 

keytool -import -alias <host name> -file <certificate file> 

-keystore <name of truststore> 

In this command: 

• Replace <host name> with the host name of the GRC server. 

• Replace <certificate file> with the SSL certificate file from the GRC server. 

• Replace <name of truststore> with the name of a truststore on the EBS or 

PeopleSoft server. Supply the name of an existing truststore, or supply an 

unused name to create a new truststore. 

As you run this command, you are prompted to supply a password for an existing 

truststore, or to create a password for a new one. 

Move the file created by the keytool command to the $ORACLE_HOME directory for 

the EBS or PeopleSoft server database.  

Installing the Oracle PEA 

On each EBS instance for which you want to enable preventive analysis, you must 

install version 7.3.3 of Preventive Controls Governor (PCG) before installing ver-

sion 8.6.4.5000 of the PEA.  
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Keep the following in mind: 

• You can install GRC 8.6.4.5000 on its server without first having installed PCG 

on any EBS instance. If so, however, AACG would not be able to apply preven-

tive analysis to Oracle EBS instances. You can implement preventive analysis 

subsequently; to do so, you would first install PCG, then the PEA, on each EBS 

instance for which you want to enable preventive analysis.  

• Even after preventive analysis is enabled, you may choose to reinstall PCG on 

an EBS instance. If so, you must also reinstall the PEA on that instance. 

• A single instance of GRC can connect to multiple EBS instances (once PEAs are 

installed on those instances). However, a given EBS instance cannot connect to 

multiple GRC instances.  

There are both an automated PEA installer and a manual PEA installation process. 

If the Oracle EBS concurrent manager server and forms server reside on the same 

instance, attempt automated installation first, as it’s simpler. If not, or if the auto-

mated installer fails, use the manual process. In either case, first complete some 

preliminary steps that apply to both automated and manual installations. 

Preliminary Steps 

If you run your Oracle EBS instance in the Linux operating system, you must set a 

display option. To do so, execute the following command: 

export DISPLAY=localhost:1.0 

As you install the PEA, you must supply the username and password of a GRC user. 

It’s recommended that you create a user called wsclient, and specify that user during 

PEA installation. For information on creating users, see the Enterprise Governance, 

Risk Governance, Risk, and Compliance User Guide. 

When you configure an Oracle EBS instance as a datasource, GRC generates a 

datasource ID number. You must supply that number as you install the PEA. Thus 

sequence matters: Install GRC on its server and configure each EBS instance as a 

datasource (see page 5-3) before you install the PEA on any EBS instance.  

In the Oracle EBS instance on which you are installing the PEA, navigate to the cus-

tom application TOP (conventionally called XXLAAPPS_TOP) created on the Preven-

tive Controls Governor forms server. Execute a directory listing to determine if it 

has a subdirectory named mesg. If not, create the subdirectory: 

mkdir mesg 

Downloading and Preparing Files 

Create a staging directory on the server that supports Oracle E-Business Suite. 

When this directory is created, complete the following steps: 

1. Locate the Enterprise Governance, Risk, and Compliance Disk in your Oracle 

media pack. On it locate grc-peainstallation-8.6.4.5-SNAPSHOT-ebs-package.zip. 

Copy it to the staging directory, and extract its contents into that directory.  

The extraction should produce subdirectories of the staging directory called db, 

fndload, Forms, and lib, each of which contains files. Also, files called grc-
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peainstallation-8.6.4.5-SNAPSHOT.jar, install.properties, and pea.properties 

reside in the staging directory. 

2. To perform the automated installation, use a text editor to open and edit the 

install.properties file in the staging directory. (For a manual installation, this step 

is unnecessary.) Provide values for the following properties: 

• APPS_USER_NAME = APPS 

Supply the username for the database schema that supports your Oracle 

EBS instance. Typically, this value is APPS.  

• APPS_PASSWORD = apps_schema_password 

Supply the password for the Oracle EBS database schema identified in the 

previous property. 

• XXLAAPPS_USER_NAME = XXLAAPPS 

Supply the username for the database schema that supports PCG, installed on 

your Oracle EBS instance. Typically, this value is XXLAAPPS. 

• XXLAAPPS_PASSWORD = XXLAAPPS_passsword 

Supply the password for the PCG database schema identified in the previ-

ous property. 

• HOST = hostname 

Supply the host name for the Oracle EBS database server. 

• PORT = number 

Supply the port number at which the Oracle EBS database server communi-

cates with other applications. 

• SID = service_identifier 

Supply the service identifier (SID) for the Oracle EBS database server. 

• FREQUENCY = 30 

Supply a number that sets the interval, in minutes, at which two PEA concur-

rent programs are to run. GRCC User Provisioning Poll handles the approval 

or rejection of preventive analysis requests in the Oracle EBS instance. GRCC 

User Provisioning Request Recovery transmits stored requests to GRC 

when communications with the EBS instance have been interrupted, then 

restored. The recommended value for both programs is 30. 

3. Execute the environment file, if it is not included in the profile. Run this command: 

. $APPL_TOP/$APPLFENV 

Automated Installation 

Once you have downloaded files and prepared them, execute the following steps to 

complete an automated installation:  

1. Navigate to your staging directory. 

2. Run the installation file. Execute the following command: 

java -jar grc-peainstallation-8.6.4.5-SNAPSHOT.jar -ebs 
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The installation program prompts for property values required by the PEA: 

• Enter GRCC user name 

If you created a wsclient user on your GRC instance, supply the value 

wsclient here. If not, supply the user name configured for any GRC user. 

• Enter GRCC password 

Enter the password for the user identified in the previous property. 

• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRC is 

installed. To verify, ping the GRC server from the server where the PEA is 

being installed. 

• Enter GRCC port number 

Supply the port number at which the GRC server communicates with other 

applications. 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRC instance 

is installed. This URL should be /grc/services/GrcService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 60. 

• Enter datasource ID 

Supply the datasource ID assigned by GRC to the Oracle EBS instance in 

which you are installing the PEA. (This value is available in the GRC Manage 

Application Datasources page; see “Determining Datasource IDs,” page 5-6). 

3. After you enter the datasource ID, the installation program presents the prompt, 

“Connect to GRC server using SSL? (Yes/No).”  

• If you select No, PEA installation proceeds without support for SSL. 

• If you select Yes, the installation program prompts for an SSL truststore 

name and an SSL truststore password. Enter the values you created as you 

ran the keytool command (see “PEAs and SSL” on page 7-1). 

4. When the file finishes running, review its log file: In the staging directory, use a 

text editor to open the file debugInstall.log. It notes status for several installa-

tion stages (Status of Packages, Status of Concurrent Programs, Status of Load 

Java, and Status of Forms), as well as for overall installation.  

• If the status for each is Success, PEA is installed. Ignore the manual instal-

lation procedure. 

• Otherwise, the debugInstall.log file lists errors that have occurred at each 

stage. Either resolve the errors and retry the automated installation process, 

or complete the manual installation process (see the next section).  
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Manual Installation 

If your Oracle EBS concurrent manager server and forms server reside on separate 

instances, or if the automated PEA installation has failed, execute a manual installa-

tion instead. Once you have downloaded files and prepared them, complete the fol-

lowing sections. 

Forms Installation 

First, install forms. The PEA uses forms in twelve languages, for which you will 

need to know language codes as you perform the installation. These codes include: 

D German KO Korean 

DK Danish NL Dutch 

E Spanish PTB Brazilian Portuguese 

F French US American English 

I Italian ZHS Simplified Chinese 

JA Japanese ZHT Traditional Chinese 

Complete the following steps: 

1. Navigate to your staging directory. 

2. Execute the following command to execute the package (PKS).  

(Here and in subsequent steps, appsSchemaName and appsSchemaPassword are the 

user name and password for the database schema used by Oracle E-Business Suite.) 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grcc_provdb_pkg.pks 

3. Execute the following command to execute the package body (PKB). 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grcc_provdb_pkg.pkb 

4. To set the environment variable, execute one of the following commands, once 

for each language. As you do, replace the placeholder CODE with the appropriate 

language code (see above). 

If you use Oracle E-Business Suite Release 12: 

export FORMS_PATH=$FORMS_PATH:$AU_TOP/forms/CODE 

If you use an earlier version of Oracle EBS: 

export FORMS60_PATH=$FORMS60_PATH:$AU_TOP/forms/CODE 

5. Execute one of the following commands to compile the library: 

For Oracle E-Business Suite Release 12: 

frmcmp_batch module=Forms/GRCC_PROV.pll module_type=library 

userid=appsSchemaName/appsSchemaPassWord 

For earlier versions of Oracle EBS: 

f60gen module=Forms/GRCC_PROV.pll module_type=library 

userid=appsSchemaName/appsSchemaPassWord 
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6. Execute the following command to copy the compiled library.  

cp Forms/GRCC_PROV.* $AU_TOP/resource 

7. To compile the forms, execute one of the following commands, once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 7-5): 

For Oracle EBS Release 12: 

frmcmp_batch module=Forms/CODE/LAASCAUS.fmb 

userid=appsSchemaName/appsSchemaPassWord 

For earlier versions of Oracle EBS: 

f60gen module=Forms/CODE/LAASCAUS.fmb 

userid=appsSchemaName/appsSchemaPassWord 

8. To back up the compiled forms, execute the following command, once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 7-5): 

cp $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 

$XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx.orig 

(If you followed recommendations as you installed Preventive Controls Gover-

nor, you selected XXLAAPPS as the application short name, and the environment 

variable shown in this command — $XXLAAPPS_TOP — is correct. If you chose 

another application short name as you installed Preventive Controls Governor, 

make sure the environment variable in this command and the next reflects the 

application short name you created.) 

9. To copy the compiled form, execute the following command once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 7-5): 

cp Forms/LAASCAUS.fmx $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 

Concurrent Programs Installation 

Change to your staging directory and, from it, run the following commands to set up 

concurrent programs that support preventive analysis. In these commands: 

• appsSchemaName and appsSchemaPassword are the user name and password 

for the database schema used by Oracle E-Business Suite. 

• XXLAAPPSUserName is the user name for the database schema that supports Pre-

ventive Controls Governor. This value is case-sensitive.  

• frequency is a number setting the interval, in minutes, between scheduled runs of 

concurrent programs (see the description of the FREQUENCY option on page 7-3).  

Execute the following command to run the User Provisioning Poll concurrent program: 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grccexecutable.sql XXLAAPPSUserName frequency 

Execute the following command to run the User Provisioning Request Recovery 

concurrent program: 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grccexecrecover.sql XXLAAPPSUserName frequency 
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Once this initial setup is complete, execute the following command once for each of 

the eleven supported languages, so that concurrent-program messages, parameter 

names, and descriptions are available in each language. As before: 

• Replace the placeholder CODE with the appropriate language code (see page 7-5). 

• appsSchemaName and appsSchemaPassword are the user name and password 

for the database schema used by Oracle E-Business Suite. 

• stagedir is the path to the staging directory in which you copied and extracted 

PEA files. 

FNDLOAD appsSchemaName/appsSchemaPassword 0 Y UPLOAD 

$FND_TOP/patch/115/import/afcpprog.lct stagedir/fndload/CODE/ 

AACG_CONCURRENT_PROGRAMS.ldt 

Load Java 

Complete the following steps: 

1. Set the DB environment of APPS (the Oracle EBS database) and execute the 

installation program, specifying a “manual” argument: 

Java –jar grc-peainstallation-8.6.4.5-SNAPSHOT.jar -manual 

This prepares the pea.properties file to be loaded into the database (as specified 

in step 5). 

2. Execute the following commands. These commands should not error out: 

dropjava 

loadjava 

3. Execute the following commands. In steps 3–5, appsUserName and appsPassword 

are the user name and password for the Oracle E-Business Suite database. 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.2-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.2-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.2.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.2.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.2.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.2.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.5.0-SNAPSHOT.jar  
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dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.5.0-SNAPSHOT.jar  

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.5.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.5.1-SNAPSHOT.jar  

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.5.1-SNAPSHOT.jar  

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.5.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.5.5-SNAPSHOT.jar  

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.5.5-SNAPSHOT.jar  

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.5.5-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.6.0-SNAPSHOT.jar  

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.6.0-SNAPSHOT.jar  

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.6.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.6.3-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.6.3-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.6.3-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.6.4-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.6.4-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.6.4-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.6.4.3-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.6.4.3-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.6.4.3-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-encryption-8.6.4.4-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peacommon-8.6.4.4-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/grcc-peaebs-8.6.4.4-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing aacg.properties 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing pea.properties 
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4. Execute the following commands to load the pea jar into the database.  

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grc-encryption-8.6.4.5-SNAPSHOT.jar 

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grc-peacommon-8.6.4.5-SNAPSHOT.jar 

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grc-peaebs-8.6.4.5.jar 

5. Execute the following commands to load the modified pea.properties file into 

the database: 

loadjava –user appsUserName/appsPassword –verbose –resolve 

grc.properties 

loadjava –user appsUserName/appsPassword –verbose –resolve 

pea.properties 

Postinstallation Steps 

Regardless of whether you used the automated or manual installation process, run 

the Generate Messages concurrent program once for each language. 

1. Log in to Oracle E-Business Suite as any user with the Application Developer 

responsibility. 

2. Select the Application Developer responsibility, and select the Requests: Run 

option in the Application Developer Navigator. 

3. The Submit a New Request window appears. In it, select Single Request and 

click on the OK button. 

4. The Submit Request window appears. In its Name field, query for Generate 

Messages. (Press the F11 key; type the value Generate Messages in the Name 

field; press Ctrl+F11.) 

5. A Parameter window appears. In it, enter the following: 

• Language: With each run of the concurrent program, enter one of the 

language codes shown on page 7-5. 

• Application: GRC Controls Custom 

• Mode: DB_TO_RUNTIME 

Click on the OK button. 

6. In the Submit Request window, click on the Submit button. 

7. A pop-up window informs you of an ID number for the concurrent request. 

Make a note of the number, and then click on the OK button to close the 

message. 

8. Optionally, verify that the request has been completed successfully: 

a. Click on View in the menu bar, then on Requests in the View menu. 

b. A Find Requests form opens. In it, click on the Specific Request radio 

button. Type the ID number of your concurrent request in the Request ID 

field, and click on the Find button. 
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c. A Requests form opens. In the row displaying information about your 

request, ensure that the entry in the Phase field is Completed (you may need 

to click on the Refresh Data button), and the entry in the Status field is 

Normal. 

d. Close the Request form: Click on the × symbol in its upper right corner. 

Installing the PeopleSoft PEA 

You can install GRC 8.6.4.5000 on its server without installing the PEA on 

PeopleSoft instances. If so, however, AACG would not be able to apply preventive 

analysis to PeopleSoft instances. To implement preventive analysis subsequently, 

install the PEA on each PeopleSoft instance for which you want to enable 

preventive analysis. (For PeopleSoft instances, there is no requirement to install an 

application comparable to Preventive Controls Governor, which is necessary in 

Oracle EBS instances.) 

As you install the PEA, you must supply the username and password of a GRC user. 

It’s recommended that you create a user called wsclient, and specify that user during 

PEA installation. For information on creating GRC users, see the Enterprise Govern-

ance, Risk and Compliance User Guide. 

When you configure a PeopleSoft instance as a datasource, GRC generates a data-

source ID. You must supply that number as you install the PEA. Thus sequence 

matters: Install GRC on its server and configure each PeopleSoft instance as a data-

source (see page 5-3) before you install the PEA on any PeopleSoft instance.  

Downloading and Preparing Files 

Create a staging directory on the server that supports a PeopleSoft Financials or HR 

instance. When this directory is created, complete the following steps: 

1. Locate the Enterprise Governance, Risk, and Compliance Disk in your Oracle 

media pack. On it, locate grc-peainstallation-8.6.4.5-SNAPSHOT-ps-package.zip. 

Copy it to the staging directory, and extract its contents into that directory. 

The extraction should produce subdirectories of the staging directory called lib, 

GRCC_AGENT_86_PS_FIN90, and GRCC_AGENT_86_PS_HR90, each of which 

contains files. Also, files called grc-peainstallation-8.6.4.5-SNAPSHOT.jar, 

pea.properties, and log4j.properties reside in the staging directory. 

2. Execute the installation program to update the pea.properties file: 

java –jar grc-peainstallation-8.6.4.5-SNAPSHOT.jar -psft 

The installation program prompts for property values required by the PEA: 

• Enter GRCC user name 

If you created a wsclient user on your GRC instance, supply the value 

wsclient here. If not, supply the user name configured for any GRC user. 

• Enter GRCC password 

Enter the password for the user identified in the previous property. 
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• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRC is 

installed. To verify, ping the GRC server from the server where the PEA is 

being installed. 

• Enter GRCC port number 

Supply the port number at which the GRC server communicates with other 

applications. 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRC instance 

is installed. This URL should be /grc/services/GrcService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 60. 

• Enter datasource ID 

Supply the datasource ID assigned by GRC to the PeopleSoft instance in 

which you are installing the PEA. (This value is available in the GRC Manage 

Application Datasources page; see “Determining Datasource IDs,” page 5-6). 

• Enter PeopleSoft SID 

Supply the service identifier (SID) for the PeopleSoft database server. 

• Enter PeopleSoft port: 

Supply the number for the port at which the PeopleSoft database server 

communicates with other applications. 

• Enter PeopleSoft FQDN 

Supply the fully qualified domain name of the PeopleSoft database server. 

• Enter PeopleSoft user name 

Supply the user name for the PeopleSoft database schema. 

• Enter PeopleSoft user password 

Supply the password configured for the username identified in the previous 

property. 

• Enable PeopleSoft PEA? (y/n) 

Enter the value y to enable the PEA, or the value n to disable the PEA. 

• Enter log4j properties location 

Specify the path to a directory in which the log4j.properties file will reside 

— PS_HOME/appserv/classes/log4j.properties, in which PS_HOME represents 

the full path to the highest level directory in which PeopleSoft components 

are installed.  

(In step 5, you’ll edit a copy of this file that’s located in your staging direc-

tory. During installation, the file will be copied from the staging directory to 

a place where it can be used, and this property tells where it should be copied.) 
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• Enter PEA log location 

Set the path an name of a log file that records information about communi-

cations between PeopleSoft and GRC. The path is PS_HOME/appserv/APP 

/LOGS/grcc-peapsclient.log, in which PS_HOME represents the full path to 

the highest level directory in which PeopleSoft components are installed, 

and APP is replaced by FIN or HR, depending on whether the PEA is being 

install on an instance of PeopleSoft Financials or Human Resources. 

• Enter interval for PEA poller 

Set a time interval, in minutes, at which an “GRCC poller” may be scheduled 

to run. The poller updates role assignments for PeopleSoft when the assign-

ments have been resolved in the GRC Manage Access Approvals page. In the 

Roles panel of the PeopleSoft User Profiles page, a user may select a link 

labeled “Schedule GRCC Poller”; if so, the poller runs at intervals defined 

by this parameter. 

3. The installation program presents the prompt, “Connect to GRC server using 

SSL? (Yes/No).”  

• If you select No, PEA installation proceeds without support for SSL.  

• If you select Yes, the installation program prompts for an SSL truststore 

name and an SSL truststore password. Enter the values you created as you 

ran the keytool command (see “PEAs and SSL” on page 7-1). 

4. The installation program generates a temporary folder in the staging directory; it 

contains grcc-peaps-864.jar for installation of PEA on PeopleSoft. 

5. In the staging directory, use a text editor to open and edit the log4j.properties 

file. Set the following property: 

log4j.appender.file.File = PS_HOME/appserv/APP/LOGS/grcc-

peapsagent.log 

In this value, replace PS_HOME with the full path to the highest level directory in 

which PeopleSoft components are installed, and APP with FIN or HR, depending 

on whether the PEA is being install on an instance of PeopleSoft Financials or 

Human Resources. 

Do not modify the values of other properties in the log4j.properties file. 

Installing the PEA 

Once you have downloaded files and prepared them, execute the following steps: 

1. Stop the PeopleSoft application server.  

To do so, use the psadmin utility: To start it, execute the command 

PS_HOME/appserv/psadmin. In either case, replace PS_HOME with the full path to 

the highest-level directory in which PeopleSoft components are installed. If 

necessary, see PeopleSoft documentation for information on using the psadmin 

utility. 

2. From the PS_HOME/appserv/classes directory, remove any jar files that start with 

“grcc,” “ag,” or “aacg.” 
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3. Copy the following files from the lib subdirectory of your staging directory to 

the PS_HOME/appserv/classes directory: 

grcc-peacommon-8.6.4.5-SNAPSHOT.jar 

grcc-encryption-8.6.4.5-SNAPSHOT.jar 

commons-logging-1.1.jar 

log4j-1.2.14.jar 

ojdbc14-10.2.0.3.jar 

4. Copy the following file from the your staging directory to the PS_HOME/appserv/ 

classes directory: 

grc-peaps-8.6.4.5-SNAPSHOT.jar 

5. Copy the log4j.properties file from your staging directory to the directory you 

specified for it in the “Enter log4j properties location” property when you ran 

the grc-peaps-8.6.4.5-SNAPSHOT.jar file. 

6. Use the psadmin utility to restart the PeopleSoft application server. (See step 1 

for information on running the psadmin utility.) 

Importing a Project 

To complete the PEA installation, import a PeopleTools project: 

1. Open the PeopleTools Application Designer. Log in as a user who has the 

PeopleSoft administrator role.  

2. Navigate to Tools > Copy Project > From File… 

3. A Copy From File dialog opens. In a field labeled “Look in:” navigate to your 

staging directory. This causes subdirectories of the staging directory to appear in 

the large, unlabeled field below the “Look in:” field, and the names GRCC_AGENT_ 

86_PS_FIN90 and GRCC_AGENT_86_PS_HR90 to appear in the a field labeled 

“Select Project from the List Below.” A Select button also becomes active. 

4. For PeopleSoft 9.0 or 9.1 Financials, select GRCC_AGENT_86_PS_FIN90 in the 

“Select Project” field, and click on the Select button. For PeopleSoft 9.0 or 9.1 HR, 

select GRCC_AGENT_86_PS_HR90 in the “Select Project” field, and click on the 

Select button. 

5. When the Copy from File dialog appears, click on the Copy button. After the 

Progress dialog disappears, confirm that application objects appear in the Applica-

tion Designer project window and click on the Save All icon or File > Save All. 

It’s important to follow instructions in the PeopleSoft Application Import/Update 

Installation Guide when you apply an application import/update project to your data-

base. Failure to do so could corrupt your database and cause you to lose customiza-

tions that you have made to your database. 
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